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Megger Baker Instruments  Patents

 #US04768380 • #US05679900 • #US05845230 • #US05854553 • #US05992237 • #US06006164 • #US06199422 

• #US06202491 • #US06275781 • #US06489884 • #US06513386 • #US06633822 • #US6,789,025 • 

#US6,792,360 • US 5,633,811 • US 5,870,699 • #WO_03_048714A1

CAUTION:  This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant 

to Part 15 of the FCC rules.  These limits are designed to provide reasonable protection against harmful interference 

with the equipment is operated in its installation.  

This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance 

with the product manual, could cause harmful interference to radio communications.  If this equipment does cause 

harmful interference, the user will be required to correct the interference.  

Due to the phenomena being observed and the material properties being measured, this equipment radiates radio 

frequency energy while in the active test mode.  Care should be taken to ensure this radio frequency energy causes 

no harm to individuals or other nearby equipment. 

Intended Use of Instrument

The EXP4000 is intended for detection motor efficiency and physical performance deterioration, and other electrical 

problems within electric machines by trained professionals.  It is intended to perform only the specified tests that this 

manual explains in detail.  Please refer to chapters in this manual concerning specific operation of the instrument.

Note on Software

While the UNIT is a Microsoft Windows® based instrument, it is specially configured and optimized to perform the 

functions for which it was designed.  The loading or operation of unauthorized software may cause the instrument to 

malfunction or cease functioning and may void the manufacturer’s warranty.

Notices
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Declaration of Conformity

Manufacturer’s Name & Address:

Megger Baker Instruments

4812 McMurry Ave

Fort Collins, CO 80525  USA

Equipment Description: On-Line Motor Monitor

Equipment Model Designations: EXP4000

Application of Council Directive 72/23/EC on the harmonization of the laws related to Member States relating 

to electrical equipment designed for use within certain voltage limits, as amended by: Council Directive 93/68/

EC and Council Directive 2004/108/EC on the approximation of the laws related to Member States relating to the 

electromagnetic compatibility, as amended by: Council Directive 93/68/EC.  Note: due to the phenomena being 

observed and the material properties being measured, this equipment does radiate radio frequency energy while in 

the active test mode.

Referenced Safety Standards:

EN 61010-1

Referenced EMC Standards:

EN 61326:2001 EN 55011 Class A EN 61000-3-2

EN 61000-3-3  EN 61000-4-2  EN 61000-4-3

EN 61000-4-4  EN 61000-4-5  EN 61000-4-6

EN 61000-4-8  EN 61000-4-11

I, the undersigned, hereby declare that the equipment specified above conforms to the above Directives and 

Standards.

Signature:

 

Printed Name: Mike Teska

Title: Engineering Manager

Notices

www.megger.com iii



Megger Acquisition of Baker Instruments

Megger Group Limited, a manufacturer of electronic test equipment and measuring instruments for power 

applications, acquired the Baker Instruments business from SKF Group in August of 2018.

For over 50 years, the Baker Instruments business has led the electrical motor testing industry and has a recognized 

leading brand and position in this area. As such, legacy products will carry the Baker Instruments or SKF brands, 

which will be supported by Megger moving forward.

Trademarks

Megger is a registered trademark of Megger Group Limited.

Windows is a registered trademark of Microsoft Corporation.

All other trademarks are the property of their respective owners.

Notices
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1 — Safety and General Operating Information

General Safety Precautions

The general safety information presented here is for operating and service personnel.  

NOTICE:  If the equipment is used in any manner not specified by Megger Baker Instruments the safety protection 

provided by the equipment may be impaired.

Symbols and Labels Used on Equipment

Fig 1:  EXP4000 safety labels.

Serialized products carry a 12-digit serial number.  These 12 digits represent the product’s manufacturing site, the 

product family, a sequential number, and the month and the year of manufacture.  

Fig 2:  Representation of serial number digit values.

Products manufactured in Fort Collins are identified by a 3.  Products manufactured by Sparton are identified by a 9.  

A new number may be assigned if another contract manufacturer is used.

The next two digits identify the product family:

01 =  AWA   02 = DX  03 = EXP   04 =  EP   05 = PP   06 = NEP   07 = ZTX  

A new 2-digit number can be assigned as new product families are introduced.

The next five digits are assigned in sequence starting with 00001.

The next two digits represent the month and the final two digits represent the year of manufacture.

Safety and General Operating Information
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Safety Warnings

WARNING:  The instrument is not waterproof.  Do not allow the opened instrument to be exposed to 

water.  Water in contact with the interior of the instrument compromises protection features and could 

result in serious injury or death.  

Because of the voltages present, testing should be conducted only by trained personnel.  Adequate safety 

precautions must be taken to minimize the risk of serious injust, death, or property damage.  

Because of the dangerous currents, voltages, and forces encountered when operating, testing or 

repairing rotating equipment, safety precautions must be taken for all tests.  Follow all safety precautions 

in this manual and required by your employer.  Due to the wide diversity of machine applications, it is 

impossible to list all general safety precautions.  However, this manual includes special safety precautions 

applicable to the use of the EXP4000.

The maximum rating of the EXP4000 is 1,000 V (500 V for DC operation).  1,000 V (500 V DC operation) 

is the maximum allowable voltage between any two of the three voltages and the ground clip.  Under 

no circumstances connect the voltage sensing circuit to higher voltage levels.  Doing so will cause severe 

damage to instrument and can seriously injure you.

Operational Safety Warnings

 � Any operator of this unit must comply with the following safety precautions:

 � Comply with your facility’s safety practices at all times.

 � Ensure physical setup does not interfere with your facility’s current or intended operation.

 � Additionally, operators of this unit must adhere to the following safety precautions to minimize the potential for 
any dangerous shock hazard conditions:

 � Use whatever safety equipment required by your organization, including eye protection, high voltage gloves, arc-
flash rated masks, hoods and any required PPC.  Prior to opening any Motor Control Cabinet (MCC), ensure that 
appropriate arc-flash protection clothing is worn.  

 � Ensure that appropriate lockout / tag-out procedures are properly understood and implemented by all personnel.

 � Every connection at MCC must be performed ONLY when rotating system is powered down or off.

 � Depending on the kind of test to be run, ensure no one is in close physical proximity to the shaft of the motor or 
any other moving part of the machinery.

 � Do not position motor phase connections near ground or near each other.

 � Do not touch the connections, PT’s, CT’s or any component under test while a test is being made.  

 � This product is grounded through the grounding conductor of the power cord if running on AC power.

 � If running on AC power, orient the unit such that the AC cord can easily be disconnected if needed.

 � Voltage ground clip must be connected to ground when the unit is running on battery power.

 � If you will be running the unit on battery power, ensure that you remove the power cord from the wall outlet 
and the unit before using.  

 � Do not coil power cord or test leads near motor leads.

 � Only authorized personnel are allowed to repair or maintain the unit. 

 � This instrument is NOT approved for use in an explosive environment.

Safety and General Operating Information
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Cleaning and Decontamination

The EXP4000 should be kept clean and in a dry environment.  To clean the unit, wipe with a clean, water-dampened 

cloth.  Do not submerge in water or other cleaners or solvents.  To clean the screen, take a soft, water-dampened 

cloth and gently wipe the surface.  

Installation Requirements

The unit may be operated flat on its bottom with the lid open.  There are no ventilation requirements.  

The unit is intended for use in Installation Category II (Portable Equipment), Measurement Category III areas , 

Overvoltage category II, and pollution Degree II Environments where occasional non-conducting condensing pollution 

can be encountered.

Power Requirements

Using the provided AC power cord, connect the unit to a grounded AC power source.  The unit’s power requirements 

are 100-240 V AC, 50-60 Hz, 3 A AC maximum current draw.  

Environment Conditions and Storage

The unit is designed for indoor use.  If used outdoors, the unit must be protected from rain, snow and other 

contaminants.  Store instrument inside in order to avoid water contamination.

The unit has been tested for use up to 2,000 m altitude.

The tester should only be operated in temperatures ranging from 41 to 104 degrees Fahrenheit (5° C to 40° C).  This 

unit is for use at a maximum relative humidity of 80% for temperatures up to 31 °C decreasing linearly to 50% 

relative humidity at 40°C.

Unpacking the Unit

Carefully remove the following items from the shipping boxes.

 � EXP4000

 � Power cord

 � CTs

 � PTs

 � Cabling

 � User manual

Shipping the Unit

The EXP4000 is shipped in factory foam-filled containers.  Should the tester need to be returned to Megger Baker 

Instruments, we recommend using the unit’s original packaging or any equivalent casing that meets the following 

specifications:

Corrugated cardboard package containers, double-walled, with a minimum burst test of 275 pounds per square inch 

and,

Two to three inches of shock-absorbent material surrounding the entire unit.

NOTE:  Cardboard, newspapers, and similar materials are not considered good shock absorbers.

Safety and General Operating Information
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2 — Baker EXP4000 Introduction

Database Management

Database management is highly important in a good predictive maintenance program.  It facilitates organization 

of periodic maintenance data.  The database section of the EXP4000 software allows the entry of identifications to 

help clarify the location of specific motors.  It can maintain multiple databases for organization of overall program 

maintenance.  For example, if a facility has two buildings with a number of motor sights in each, it may work best if 

there were a database created for each building.  

Consequences of Not Organizing Data into Databases

Since the EXP4000 can be configured to store every test it ever performs, an organized structure is needed to 

facilitate data integrity and usefulness.  Also, creating multiple databases allows easier management of file size and 

archiving.

Plant Maintenance

It is common for plants to have duplicate processes, with identically named motors in each process.  (ex: intake 

pump) This can cause confusion, since the motors are in different locations, but have the same motor ID.  Take steps 

to make motor ID’s unique.

For example, the motor ID for process 1 should be intake pump P1 while the motor ID for process 2 should be intake 

pump P2.

Database Features

The records that are stored by the EXP4000 are linked to each other hierarchically.  The principle record, which serves 

as the base for linking associated records, is the machine ID.  Information entered into machine ID and test ID records 

become part of the database.  Like other database information, it can be transferred to other computer programs or 

other computers.

Navigating the Software Interface

Familiarity with Windows 98se®, Windows NT SP4®, Windows 2000®, Windows XP®, Windows 7®, or Windows 

10® and basic computer skills is assumed.  Working with the EXP4000 software requires a general understanding of 

using multiple windows, a variety of keyboard commands, and a pointer device (mouse).  

Upgrading Databases from Previous Software Versions

Before the EXP4000 software can open a database from previous versions of the software, it must upgrade the 

database.  This upgrade tool will pop up whenever you open a database that can be upgraded.  It will place the file in 

a default directory.  This directory must be a separate database from the one where existing data is stored.  After the 

database is upgraded, it will automatically open in the software.  

NOTICE:  Upgrading a database does not delete the old database.  It allows expanded capabilities within the new 

software to be used, while permitting the use of older versions of software on the old database.

An application is available to automatically update all databases at once.  Contact Megger Baker Instruments support 

for information on obtaining and using this application.

Baker EXP4000 Introduction
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EXP4000 Software-specific Features

Grey-shaded fields

Gray-shaded fields are generally not editable.  Fields with white backgrounds are editable.

Text fields

Text fields are areas that contain editable words or numbers.  To edit text fields, press or click in them and type.  The 

software will prompted you for missing information required by the EXP4000 if a necessary field is left blank.  This is 

generally seen when creating or editing motor or machine properties.

Arrows and windows icons

In the EXP4000, arrows serve two functions.  They allow you to access information that does not fit on the screen or 

they allow you to change numbers in a text field.  For example, clicking on either the up or down arrow can change a 

caution threshold for the voltage unbalance test in an electrical test model.

Numeric fields

The two types of numeric fields are input and display.  The input fields are required to calculate portion of the result 

panels or allow entering additional information to the reports.  All other numeric fields are display results.

Starting the Software

1. To start the EXP4000 software, click on the Explorer icon on the desktop or click on Start-> All Programs-> 

Explorer-> Explorer.  The Explorer main window appears as shown below.

Fig 3: EXP4000 user interface.

2. When you click on File in the Main toolbar then select a database, the Machine tree populates as shown in the 
example above.

Baker EXP4000 Introduction
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3. Clicking on a machine in the list populates the rest of the interface as shown.

 � The Main toolbar, located a the top of the interface, provides the primary controls for access to test and machine 
information, along with tools used to conduct tests.

 � The Machine information bar identifies the current motor or device under test along with the basic nameplate 
information for the machine.

 � The Waveform display provides the primary graphical representation of the waveforms saved for the related 
measurement.  The voltage waveform display can be set to Line to Line or Line to Ground mode via the Options 
Display tab under the Tools menu.

 � The Test domain buttons provide access to specific test results and indicate the status of test results.  

 � The Torque time/speed display shows the torque/time measurement acquired in VFD operation mode or the 
torque/speed measurement acquired in line operation mode.

 � The Display phasor icon open a new window showing the Phasor diagram for the related machine.

 � Numerical display fields to the left of the Waveform display provide measurements collected for the single phase 
to neutral voltages or line-to-line voltages (depending on the setting in the Tools Options menu), single-phase 
currents, average, power factors, average current, total electrical input power and average line-to-line voltage.  
These fields include:

 � Voltage [V]—average line-to-line voltage.

 � Current [A]—average line current.

 � PF—power factor.

 � V Unbal [%]—voltage unbalance percentage.

 � I Unbal [%]—current unbalance percentage.

 � Numerical display fields to the right of the Torque time/speed display provide measurements collected for the 
motor’s mechanical and electromechanical operating condition.  These fields include:

 � Efficiency [%]—efficiency percentage

 � Torque [ft-lb]—motor torque in foot-pounds (or Nm if set to metric).

 � Load [%]—percent load to the motor under test.

 � Load [hp]—energy load to the motor under test.

 � Speed [RPM]—speed of the motor.

 � Sensor—portable (internal) or EP (external).

 � CTs—current rating of the CTs.

 � Auto-Phase—used during line operation to set up the line and current inputs.

 � Test date/time dropdown menu and controls— This text field displays the time of the current and previous test 
data.

NOTE:  Pressing the [F1] key on your keyboard opens context help for the window.

Baker EXP4000 Introduction
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Test Domain Buttons

Each test domain button provides access to its specific test results.

Because each threshold equates to a specific color, the software assigns a color to the domain and the testing 

domain buttons depending on the test result.  For example, if the result of the voltage unbalance test falls below the 

established caution thresholds, the software would assign the color green to the voltage unbalance button.

Results Panels and Windows

Clicking on any of the test domains opens a test results panel that you can use to select test results to display in a 

window like the one shown in the example below.

Fig 4: Selecting test results to display using Results panels.

The contents of the results dialog box varies depending on the related test type.  Many include two tabs—Result and 

Trend—as shown in the example above.  

Baker EXP4000 Introduction
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Result Tab

In this example of the Result tab, we see three main sections.

The Measurement display indicates the severity of the test results compared to the threshold indicators.

The Threshold bars display the current threshold level.  The threshold is user specified in the electric model.  Each bar 

has an associated color level:

 � Red = warning

 � Yellow = caution

 � Green = good

 � Blue = no applicable threshold

The numeric display in the lower panel presents relevant test result data such as the NEMA percentage derating 

factor, the percentage load, and amplitudes for the voltage phasors.  

Trend Tab

The Trend tab displays trending data for the relevant test.  It displays the value of the monitored quantity (y-axis) 

against the test numbers (x-axis).  The x-axis shows the number of measurements performed for that particular motor 

ID.

 

Fig 5: Trend tab.

The Trend tab allows you to access specific test results by clicking and holding the left mouse button on the marker 

and dragging it to a new location.  Each test result contains the date and time for the test and important numeric 

results, which will change to display the new test results data when you release the mouse button.

Baker EXP4000 Introduction
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Machine Tree

The left panel in the main user interface window is the Machine tree.  The highest level is the database name  

(depicted by a file cabinet icon).  Folders are used below each database to store machine test data or other folders.  In 

turn, machines are stored within the folders. 

1. Use the plus and minus icons to the left of tree elements to locate the machine that you want to test.

2. Click on the target machine to highlight it.  Its name and related nameplate information will appear in the 
Machine information bar just to the right.

3. Ensure that the EXP4000  is properly connected to the machine.

4. Press Run Electrical to start testing and data collection.

5. Alternatively, you can click on the Tools menu then the Run Electrical item.

Fig 6: Machine tree used to find files and folders for testing.

Baker EXP4000 Introduction
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Keyboard Shortcuts

 � F1 key on the keyboard opens the loaded Help environment.

 � F2 key opens the machine properties.

 � F3 key operates the New AC Machine function.

 � F5 key operates the Run Electrical function.

 � F7 key opens the Virtual Scope feature.

 � F8 key displays the View Connections function.

 � F9 key operates the Transient Analysis Dialog

 � Ctrl A – About

 � Ctrl M – User Manual

 � Ctrl O – Open Database

 � Ctrl N – New Database

Software Tips

Popup panels require you to immediately interact with dialogs that affect displayed data (loaded or part of a test).

The time required to load a machine with a large number of tests has been decreased by internally connecting or 

threading the test logs.  

When the machine is loaded, but the thread is not completed the message “Test log is Loading” appears instead of 

the test log graphs.  This can cause a perceived lag if you quickly switch machines or delete test results from motors 

with more than 100 stored tests.  This lag time will also be noticeable if you load a machine with a large number of 

tests and then exit.

At this publishing, we recommend keeping the number of tests per motor to a maximum of 2000.

Baker EXP4000 Introduction
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3 — Connecting the EXP4000

NOTICE:  Ensure that all safety warning and procedures have been read and are understood before proceeding with 

any setup process.

Refer to the “Safety and general operating information” chapter for details.

WARNING: For all connection procedures: to minimize risk of injury or death from electric shock, make 

sure the motor iis turned off before opening panels or making connections.

NOTE:  Make sure the current direction arrow points in the direction of the load when connecting current clamp-ons.  

Voltage clip-ons and current clamp-ons should be connected to the cold side of the breakers.

Installing an EP1000

If the EXP4000 will be used with an EP1000 Dynamic Motor Link, refer to the installation manual for that device 

by selecting Help  EP Calibration in the Explorer software.  You may also contact the Service Department and ask 

for document number: 71-028 or visit the online technical assistance site https://us.megger.com/support/customer-

support.

Physical Setup of EXP4000 with Portable Sensors

1. Connect the marked voltage clip-ons to the voltage port on the EXP4000.

2. Connect the marked current clamp-ons to the current signal port on the EXP4000.

3. Turn on power to the laptop.

4. Double click the EXP4000 icon to start the program.  

Connecting the EXP4000 to the MCC

CAUTION:  Disconnect voltage clips prior to disconnecting voltage leads from the EXP4000 port to avoid exposing 

the EXP4000 port connector to high-voltage. 

1. Open the panel of the MCC.

2. Connect a voltage clip-on to each phase of the breaker.

3. Attach one current clamp-on per phase.

Both the current and the voltage sensors of the EXP4000 are designed for low voltage.  AC voltage sensors are rated 

for 1000 VAC.  DC voltage sensors are rated for 500 VDC  Attach Hall Effect CTs and DC Voltage Sensors for DC 

Motor testing applications.  In order to measure medium or high voltage motors, additional CTs and PTs are required.  

In this case, the current clamp-ons and voltage clip-ons have to be connected to the CTs and PTs on your site.

4. The voltage clip-ons and current clamp-ons should match color-wise on each phase.  Ex.  The yellow voltage clip-
on should be attached to the same phase as the yellow current clamp-on.

EXP4000 Connections to Motor Terminals

1. Connect the current clamp-ons and voltage clip-ons to the terminal box.

2. The voltage clip-ons and current clamp-ons should match color-wise on each phase; for example, the yellow 
voltage clip-on should be attached to the same phase as the yellow current clamp-on.

3. Attach one voltage sensor to each phase.

4. Exercise extreme caution to make sure that no terminals or clip-ons touch each other or touch ground when 
energized.

Connecting the EXP4000

www.megger.com 13



5. Prior to energizing the motor, exercise extreme caution to make sure that no terminals or clip-ons touch each 
other or touch ground.  Energize the motor.

Physical Setup of the EXP4000 with EPs

See Appendix D for installation instructions for EPs.

1. Connect the EXP4000 end of the mixed AD cable to the MCC port on the EXP4000.

2. Connect the other end of the mixed AD cable to the MCC plug.

3. Set the Sensors option of the main panel to EP.

4. Click on Run Electrical.

Connection Setup Window

When performing an electrical test on a line operated motor, one of two warnings can appear.  The first warning will 

appear if the Auto-Phase feature is not activated (box checked in the main window), and the EXP4000 realizes that 

the connection is mistaken (for example, having the current and voltage connections being in acb and abc sequence, 

respectively).  The second warning will appear if Auto-Phase has failed due to excessive unbalances on the measured 

currents or voltages.  This can be from lacking one voltage signal, not having properly closed a CT.

Clicking on Yes will take you into the connection setup wizard.  Clicking on Continue Test will continue testing using 

the physical setup.  Clicking on Abort Test will stop the test without saving any information to the database.

Setup Wizard/Suggest Button

Fig 7: Connection Setup window showing Suggest button.

When the connection setup wizard appears the Suggest button is available.  The Suggest button’s purpose is to offer 

reasonable solutions in error mitigation.  If there is more that one realistic solution, you will be prompted about load 

level.  A selection of a high load scenario (90% and higher) or a low load scenario (20% and lower) can be made.  

This dialog rarely pops up.  

NOTE:  This high load and low load scenario may be an indication of incorrectly entered nameplate data.

Connecting the EXP4000
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Two-CT Solution

The two-CT solution is based on Kirchhoff’s law of currents: The sum of currents into a node is equal to zero, 

Ia+Ib+Ic+Ig=0.  

NOTE:  Calculating the current of the third phase is only valid while there is no noticeable ground current (Ig=0). This 

is typically the case; however, a high impedance ground system with one grounded phase is an exception.

A two-CT setup is needed if you are physically unable to connect all three CTs, or if all three CTs are connected, but 

one did not close or it is connected to a wrong wire.  If two or more CTs are not connected then the test should be 

aborted and the CTs manually adjusted.  

In the example below, the blue CT is disconnected and an electrical test is performed.  Notice that the amplitude is 

zero.  

If the CT is not totally closed the phasor will be greater than zero, but noticeably less than the other CTs.  

Fig 8: Connection Setup window indicating connections need to be checked.

Fig 9: Connection Setup window indicating connection are good.

Connecting the EXP4000
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Manual Phasor Adjustments

Manually adjusting the phasors can quickly become confusing.  If the Suggest button does not provide a solution, or 

if there is not a unique setup, then manually adjusting the phasors might be necessary.  

Adjustments are exactly the same as those made in the MCC when properly connecting the EXP4000.  There are two 

rules for adjusting phasors:

1. All Phasors (currents and voltages) should have an angle between them of  120 degrees ± 5.

2. For all induction motors, the current phasor must follow the voltage phasor by a maximum of 90 degrees.  

The graphic below illustrates all phasor positions.  All three current phasors must be in the same area in order for the 

setup to be correct.  For example if the Ia phasor is in the high load position, Ib and Ic must also be in the high load 

position.  The dark shaded are non-phasor positions.  Although this can be done mathematically, phasors cannot 

physically reside in the dark shaded areas (three phase induction motors) without PF correcting devices.

 

Fig 10: Phasor diagram.

There is the possibility that phasors can reside in the high load position or be rotated 180 degrees and be in the low 

load position.  In order to minimize potential errors, we have provided a load estimate.  If the phasors are setup in the 

high load position and the load estimate is 300 percent or higher, then the most likely correct solution is to rotate the 

phasors to the low load position.  

NOTE:  To go from a high-load position to a low-load position, rotate each dial one position to the left.  To go from a 

low load position to a high load position: rotate each dial to the right one position.

Connecting the EXP4000
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4 — EXP4000 Tests

Test Domains and Testing Theory

The EXP4000 utilizes a multitude of tests to determine the power condition, health, load, and energy profile of 

machines.  

The following test domains describe the functionality of the instrument along with a description of each test.

Testing Capabilities

The EXP4000 is equipped with standard software to initiate testing.  Additional software can be purchased if 

necessary to complete the program you deems necessary.  This additional software is explained in chapters later in 

this manual.  The standard software includes the following domains and tests:

 � Power Quality:  Voltage Level, Voltage Unbalance, Harmonic Distortion, Total Distortion, Power, Harmonics

 � Machine Performance:  Effective Service Factor, Load, Operating Condition, Efficiency, Payback Period

 � Current:  Over Current, Current Unbalances

 � Spectrum: Rotor bar, V/I Spectrum, Harmonics

 � Connection:  Waveforms, ABC/SYM Comp., Phasors

To view any of these tests, click on the associated domain and then on the associated test.  Many of these viewable 

panels will have results and test log views.  

Each domain test window includes a Result tab and a Trend tab.  The Result tab displays results of the current test.  

The Trend tab graphically displays the current test results along with previous test results.

Power Quality Domain

Voltage Level

 � Identifies over- and under-voltage conditions.

 � Compares measured voltage levels with user-defined thresholds.

Fig 11: Voltage level test within the Power Quality domain.

EXP4000 Tests
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Voltage Unbalance

 � Examines the single-phase voltage in the motor by calculating its percentage unbalance via NEMA derating.

 � Compares the voltage unbalance level with the stored threshold.

 � An unbalanced voltage condition causes negative sequence currents within the stator, resulting in excessive heat.  
The voltage unbalance test determines if an unbalanced voltage condition exists in the machine.  The EXP4000 
utilizes the NEMA derating curve that specifies a maximal load for each type of unbalance.

Fig 12:  Voltage unbalance within the Power Quality domain.

NOTE:  The value in the NEMA Derating field will equal 1 unless there is voltage unbalance and 5,7,11,13 order 

voltage harmonics are present.

EXP4000 Tests
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Harmonic Distortion

The harmonic distortion function examines the total harmonic distortion of the three single phases to neutral 

voltages.  It compares the level of total harmonic distortion to the threshold values that you define.

Fig 13: Harmonic distortion.

Stator current, torque, and operating speed typically describe the health of a machine.  For example, maintenance 

personnel should be alerted if a machine needs to run at a lower speed in order to provide the same torque.  The 

machine may have an issue caused by broken rotor bars, excessive heat, or varying voltage conditions.

EXP4000 Tests
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Total Distortion

Both Total Harmonic Distortion (THD) and Total Distortion (TD) deal with quantifying the effect of nonfundamental 

components to the voltage and current waveform.  Whereas the Harmonic Distortion focuses on the harmonic 

content alone, Total Distortion focuses on all nonfundamental components.

Fig 14: Total distortion within the Power Quality domain.  

The commonalities and differences between THD and TD are:

 � THD adds only harmonic components and divides by the fundamental.

 � TD subtracts the fundamental from the RMS and divides by the fundamental.

 � THD is defined in IEEE and NEMA standard, whereas, TD is not defined in these standards.  

 � THD delivers reliable results for line-operated machines.

 � TD delivers reliable results for all machines.

 � For all applications, TD values must always result in higher values than THD.

EXP4000 Tests
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Power

The Power window provides information to define power qualities for each phase along with the average / sum 

values.  

The window has five major sections.

The first section displays kilowatts (kW), kilovolt amperes (kVAr), and kilvolt amperes (kVA).

The next section displays the power factor (PF), voltage (V), and current (I) values.

Total harmonic distortion voltage  (THD V) and total harmonic distortion current (THD I) are presented in the third 

section.

The crest factor voltage (Cf V) and crest factor current (Cf I) values are shown in the fourth section.

The voltage unbalance percentage, current unbalance percentage, and frequency are presented in the last section.  

Fig 15: Power data displayed within the Power Quality domain.

EXP4000 Tests

www.megger.com 21



Harmonics

The Harmonic components compare the magnitude of the harmonic components to the fundamental currents and 

voltages of the system.  The bar chart displays the distribution of the harmonic content on the different frequency 

bands for all currents and voltages.

Fig 16: Harmonics within the Power Quality domain.

1. Select the voltage and current channels that you want to display by checking the boxes next to the desired 

channels in the Select Channels section.

2. Adjust the harmonics range that you want to displayed by using the From and To combo boxes found in the 
Show Harmonics section.

3. Click on the Export button to export the data collected to a comma separate values (.CSV) file.

EXP4000 Tests
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Machine Performance Domain

Effective Service Factor

 � Graphically displays the estimated percentage load derated with the NEMA derating factor,

The Effective Service Factor test identifies how closely the motor is operating to its effective service factor.  The test 

predicts heat-based deterioration and provides an accurate thermal assessment of the motor.

Fig 17:  Effective Service Factor within the Machine Performance domain.
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Load

This displays the estimated load for the machine, and compares it with defined thresholds.  A 100% threshold 

is commonly used since operating above that level may rapidly thermally deteriorate the machine.  However, a 

combination of environmental conditions and criticality of the machine may warrant moving the threshold level to 

a higher or lower value.  For example, additional cooling of the machine may be a reason for allowing a higher load 

level prior to issuing an alarm.

Fig 18: Load test within the Machine Performance domain.
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24 Baker EXP4000 71-005 EN V9 User Guide               www.megger.com



Operating Condition (OpCond)

Each induction motor has a torque-speed and current-speed characteristic operation curve.  These curves will vary 

their signature if an induction motor’s operation changes from healthy to a faulted condition.  For example, increased 

operation temperature, fluctuating environmental conditions, varied power supply conditions, or broken rotor cages  

can alter a motor’s operating condition.  

Differences in operating condition could indicate two things:

 � a change in the operating process, or

 � a condition that may influence the motor’s operation.

A resultant warning does not necessarily imply a defect in the machine, load or power supply.  However, it is 

important to monitor the machine’s operating condition.  Any identifiable changes could affect the future operation 

of the motor.

 

Fig 19: Operating condition test within the Machine Performance domain.

Efficiency

Efficiency is the ratio of the mechanical output of the motor’s power to the electrical input power to the motor.

Where:

Ploss = the power that dissipates (mainly heat)

Pin = input power

Ploss can bee seen as potential energy waste in the power bill and it degrades motor health.
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The efficiency test displays the motor’s operating efficiency and previously measured motor efficiencies.  Low results 

in the efficiency test suggest that motor retrofits may be advisable.  A decline in efficiency may indicate an increase in 

the motor’s operating temperature, causing faster motor degradation.

A manufacturer database with more than 20,000 different motor designs is provided.  This database compares 

existing motors with similar designs that perform at or above EPAct’92.  These motors are compared with respect to 

current operating load point, and their resulting efficiencies.  If the efficiency of the motor under test is significantly 

lower than the target efficiency found on a EPAct motor, a warning or caution flag is issued.  

If an efficiency warning or caution flag is issued, the following steps should be taken:

1. Check that the correct stator and lead line-to-line resistances have been entered into the Create Motor or Edit 

Motor panels in the EXP4000 software.

2. Motors can operate at low efficiencies because of their design, or poor power conditions.  Check that the voltage 
level is appropriate for the motor tested.  Make sure voltage unbalance and voltage distortion are acceptable.

NOTE:  To ensure the accuracy of the efficiency estimation, the correct stator resistance must be entered for the 

motor when the new AC machine is created.

 

Fig 20: Efficiency test within the Machine Performance domain.
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Payback Period

This test searches the database for motors, and compares the energy expenses of the motor under test with higher 

efficiency motors.  Payback period is calculated, based on the compared motor’s list price, the energy savings 

calculated according to the specified duty cycle of the motor, the entered $/kWh, and the latest calculated input 

power of the motor.  This test uses the premise that the comparison motor operates, on average, on a load point 

similar to the one measured.  All prices are in USD, so the energy costs have to be specified in USD.  List prices are 

motor manufacturers’ data, and are based upon the U.S.  market.  If the EXP4000 is used in countries outside of the 

U.S., the list price should be adjusted accordingly.

 

Fig 21: Payback period within the Machine Performance domain.
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Current Domain

Current Level

The current level function compares the single-phase current with the stator current listed on the tested motor’s 

nameplate.  Too much current can overstress particular phases in the machine.  The current level test determines if 

the machine might be drawing more than its rated current on one or more phases.  This causes excessive heat and 

decreasing life of the insulation.

 

Fig 22: Current level test within the Current domain.

EXP4000 Tests

28 Baker EXP4000 71-005 EN V9 User Guide               www.megger.com



Current Unbalance

Unbalanced currents are frequently caused by unbalanced voltages.  A common rule of thumb is that voltage 

unbalance can be the cause of up to eight times larger current unbalances.  Machines will also show very large 

current unbalances under very light, or no load conditions—even when driven by a balanced voltage.  These no-load 

current unbalances are common in healthy machines, and they vanish rapidly when the machine is loaded.

 

Fig 23: Current unbalances within the Current domain.
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Spectrum Domain

Rotor Bar

The rotor bar function records the relative amplitude of the rotor-bar sideband, and compares the rotor cage 

signature to stored thresholds.

 

Fig 24: Rotor bar within the Spectrum domain.

The rotor bar test evaluates the overall condition of the machine.  Broken rotor bars cause excess heat on the 

machine, decreasing efficiency, shortening insulation life, and possibly causing core damage.
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V/I Spectrum

The V/I Spectrum window analyzes the frequency spectra of the three line-to-neutral voltage waveforms and the 

three line currents independently of each other.  The current spectra have shown to contain information related to 

the vibration spectra of the machine; roller-bearing faults can be identified by using the frequency marker controls 

on the lower left.  The feature can also help you find deteriorating alignment problems, load unbalances, looseness, 

eccentricity, and cavitation by analyzing these spectra.

 

Fig 25: V/I spectrum within the Spectrum domain.

You can zoom in  on (enlarge) specific regions on the graph by clicking and holding the left mouse button and 

dragging your mouse cursor to select the desired area to enlarge.  More information about how to zoom can be 

found by clicking on the Zoom Info item in the toolbar at the top of the window. 

V/I Spectrum graphs also have a Graph Options item in the menu bar, which you can use to define masking 

preferences of the electrical frequencies. In addition, the width of the mask (in Hertz) can be defined.

Just below the Zoom Info menu, you will see two icons.  The first one allow you to export the spectra data to a 

spreadsheet. The second icon enables the display of time waveform data below the spectrum graph.
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Demodulated Spectrum (option)

Available with the purchase of the T4000 Torque analysis software option, the Demodulated spectrum feature 

calculates the three-dimensional demodulated spectrum of the torque signature.  With the channel control, this 

signal can be changed from torque to current or voltage of any one of the phases. The demodulated spectra tool 

analyzes the dynamic behavior profile of the motor load system.

Fig 26:  Demodulation Spectra window elements.

The main information of the Demodulated Spectra window is the three-dimensional demodulated spectrum graphic 

and the frequency of spectrum graph. 

The Marker can be moved by a simple drag-and-drop operation.  

1. Hover the mouse cursor above the marker, which changes to a pointing finger. 

2. Click on hold down the left mouse button then move the cursor to the new point of interest and release the 
button.

The marker’s location determines the projections plotted on the Frequency of spectrum and Band projection graphs.  

It shows the relative amplitudes of the frequency for the different bands of AM demodulation.  

The Frequency scale at the bottom of the three-dimensional graph has the same meaning as the scale below the 

projection. Typically, frequency components of interest are read on these scales. 

The Channel selector position determines the demodulation algorithm that needs to be run for voltage or current of 

the phases (A, B, or C), or over the default torque setting. The graph amplitude is displayed in volts, amps, or Newton 

meters. 

The Frequency Range setting allows for zooming in or out on the display. 

The Band scale identifies the different AM demodulation bands that have been analyzed via the DFLL. 

The Viewing controls change the three-dimensional graph settings. Disabling the Projection Only view and enabling 

the Zoom/Rotate options allows changes to viewing the three-dimensional graph. The particular keys for zooming, 

panning and restoring, are described in the Zoom Info link found in the top left corner of the window.
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Harmonics

The Harmonic components compare the magnitude of the harmonic components to the fundamental currents and 

voltages of the system.  Bar charts display the distribution of the harmonic content on the different frequency bands 

for all currents and voltages.

Fig 27: Harmonics within the Spectrum domain.
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Torque Domain

Also made available with the purchase of the T4000 torque analysis software option is access to the Torque testing 

domain, which provides access to the Torque Ripple and Torque Spectrum testing features.

Torque Ripple Results Tab

The Torque Ripple window has two tabs: Results and Trend.  The Results tab shows the measured torque over time 

compared to the rated torque calculated from the motor nameplate information.

Fig 28: Torque Ripple window—Results tab— within the Torque domain.
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Torque Ripple Trend tab

The Trend tab shows a graphical comparison of the torque results for the current and previous measurements.  

Fig 29: Torque Ripple window—Trend tab—within the Torque domain.
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Torque Spectrum

Clicking on torque spectrum opens a window that shows the frequency spectra of torque. The Y-scale display units 

can be set to logarithmic, linear, or decibel. 

You can zoom in  on (enlarge) specific regions on the graph by clicking and holding the left mouse button and 

dragging your mouse cursor to select the desired area to enlarge.  More information about how to zoom can be 

found by clicking on the Zoom Info item in the toolbar at the top of the window.  

When the new enlarged area is identified using the zoom feature, the software will display the frequency 

components of the signal  located between the vertical markers. 

Markers in the graph can be moved by clicking and holding the left mouse button and dragging the marker to a 

desired new location.

 This means that the narrower the window between the markers is, the higher the resolution. 

Fig 30:  Torque Spectra window within Torque domain.

The y-axis scale can be set to either logarithmic, linear or dB. The x-axis can be displayed in either Hertz or KCPM 

(1000 CPM).

Frequency markers can be added to display the frequencies of known faults. You can add bearing markers by clicking 

the + below the list of available markers. The frequency band can be changed and allows you to control which 

harmonic of the fundamental will be used to mark the frequencies of interest.  In torque, fault frequencies will be 

most prevalent at DC (Freq. Band 0), other frequency bands can be selected to verify the presence of a fault. Using 

the harmonics multiples you can mark N multiples of the frequency of interest and sideband markers can also be used 

to examine the haystack around a Nth harmonic.

Data can be exported to CSV format so that in can be easily imported into MS Excel® or other programs by clicking 

on the Export Data icon found just below Zoom Info.  You can choose to export Spectrum Data or Time Waveform 

Data.

The icon to the right of the Export Data icon allows you to toggle time waveforms on or off.

Torque graphs also have a Graph Options item in the menu bar, which you can use to define masking preferences of 

the electrical frequencies. In addition, the width of the mask (in Hertz) can be defined.
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Connection Domain

Waveforms

The Waveforms window displays the waveforms for all three current and voltage measurements for line operated 

mode.  If the EXP4000 is operated in VFD mode (not available in basic software), it shows the voltage and current 

measurements for phase A.

 

Fig 31: Waveforms in the connections domain.

1. Use the dropdown list just above the display area to select how the data will be displayed: line-to-line or line-to-

neutral.

2. The data can be exported to a comma separated values (.csv) file by clicking on the Export Data icon just to the 
right of the dropdown list.

3. Zoom in on the graph by pressing and holding the left mouse button and drawing a rectangle around the area of 
interest.  Zoom characteristics are described in the Zoom Info menu found just above the display area

4. Checking the boxes below the display area tells the software which measurements it needs to display.  
Measurements are color-coded to ease identification.
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Symmetrical Components (Sym. Components)

The Symmetrical Components window displays the voltage, current and impedance unbalance, the positive sequence 

(accelerating), and the negative sequence (retarding) current, voltage, and impedance information.

 

Fig 32: ABC/SYM Comp within the Connection domain.

Phasors

The Phasors window shows the a,b,c phasors for voltages and the current in line operated mode.  

 

Fig 33: Phasors within the Connection domain.
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5 — EXP4000 Software Overview

This chapter is intended to convey a general knowledge of how to use and navigate EXP4000 software, with a step-

by-step guide through the software menus and procedures for data collection and management.

File Menu

The File menu is used to upload and save motor data files.  It includes the following items: Database, Report 

Generator, Summary Report, and Exit.

Fig 34: EXP4000 software File menu.

Database

Selecting the Database menu item provides you with options to open an existing database file, create a new file, or 

close an existing file.

To create a new database:

1. Click on the File menu, Database then New.

2. Type the name of the new database in the File name field.

3. Click on the Save button.

To open an existing database:

1. Click on the File menu, Database then Open.

2. If needed, locate the database in the file structure then click on the database to be opened.  Its name should 
appear in the File name field.

3. Click on the Open button.

NOTE:  Changing databases during operation is allowed by using the preceding procedure.  

To close an existing database:

If multiple databases are open, select the one you want to close.

Click on the File menu, Database then Close.  This will automatically close the database.
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Report Generator

The reports section offers the ability to customize reports to see multiple tests with different filters and trending 

options.

The Filter On option helps you select good, caution and/or warning results.  It also allows you to select a date range 

to request specific tests for the report.

The Select options helps you select results via  All, All Good, All Caution, All Warning, All Warning and Caution, or 

None parameters.

The Trending option provides parameter selection by choosing All Machine Results, Selected Results Only, and Plot 

Mode.  Plot Mode provides further resolution by allowing you to select Line or Point + Line. 

  

Fig 35: Select Results dialog for generating reports.

The EXP4000 software generates an .rtf file that can be opened in  Microsoft Word®, WordPad or other word 

processing programs for editing.  Remember that report page count will increase dramatically with the addition of 

multiple tests.  This can increase time in report generation and printing.  
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Summary Report

This option will print an overall summary of the testing done for the selected machine test in the Machine Tree.   

Fig 36:  Machine Performance Report screen.

These reports options include: Main Panel, Power Condition Report, Machine Condition Report, Energy Assessment, 

Machine Performance Report, and Load Reports.  These items will print the panel page for that specific test.

The value in the Location field is determined by the name given to the first-level folder located in the database the 

motor resides in. The value in the Building field is determined by the name given the second-level folder located in 

the database the motor resides in.

Clicking on the Test Notes item in the Tools menu populates the Memo, Test by, and Test For fields.

Exit

The Exit menu item closes the program.
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Machine Menu

The Machine menu provides you with the tools to assign, create, edit, or delete particular motors or other devices to 

be tested.  Under the Machine menu are the following options: New AC Machine, Machine Properties, Acquire EP 

Serial Number, and Reset EP Serial Number.

Fig 37: Machine menu.

New AC Machine

Clicking on the New AC Machine menu item opens a dialog box used to generate a new machine ID, which is 

required to run electrical tests.  The Machine Properties dialog box includes three tabs: Name Plate, Machine 

Information, and Dynamic Testing.

Fields within the Name Plate and Machine Information tabs appear in red when required information is needed.  All 

fields in red must be filled with appropriate data before the software will allow you to continue with the process.  

Fields marked in yellow can affect the results the EXP4000 can generate.  Remember that the more information that 

is accurately entered, the more comprehensive the results will be.  The software prompts you for missed information.  

The EXP4000 software also includes IntelliCreate technology, which checks the applicability of entered data.  

IntelliCreate identifies the majority of typos and omissions of data fields during machine creation.  
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Name Plate Tab

As indicated by the red fields when first opening, data entry is required for nearly all fields in this tab.   

Fig 38: Create Machine Name Plate tab.

1. Click in the Name field and give the motor/device an appropriate name, typically reflecting the process that it is 

running.

2. Use the Tab key on your keyboard to move between the fields in the Name Plate tab and enter values for each 
required field.

3. Enter values in other fields to provide more resolution and to improve report quality.

4. Some items will be automatically calculated and their values automatically entered in the appropriate related 
fields.  For example, the corresponding Power Out [kW] data will be automatically entered to complement the 
Power Out [hp] entered.

5. Check the VFD box if the motor is being driven by a variable frequency drive device.

6. If you have a Delta-to-Y or Y-to-Delta step-up/step-down transformer feeding your motor with PTs installed on 
one side of the transformer and CTs installed on the other, check the Phase Shift box and set the value to add or 
subtract (as needed) 30 degrees of phase shift between the voltage and current phasors. This will compensate for 
the 30-degree phase shift between the primary and secondary sides of the Delta-to-Y or Y-to-Delta step-up/step-
down transformer.

7. If you have your PTs attached to one side of this type of transformer and the CTs on the other side, to get correct 
readings you will use this feature to add/subtract 30 degrees of phase shift between the voltage and current 
phasors.

8. Continue with the Sensor Ratios button instructions if you are connecting to the secondaries of CTs and PTs; 
otherwise, proceed with entering data in the Machine Information tab.
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Sensor Ratios Dialog Box

1. When connecting to the secondaries of CTs and PTs (typically done when working in the field), click on the Sensor 

Ratios button to open a dialog box like the one shown below.

2. Enter the voltage and current ratios as needed, then click on OK.  

Fig 39: Sensor Ratios dialog box.

NOTE:  This needs to be set up with the ratios of the PTs and CTs whenever a motor is tested at the low voltage side 

of PTs and CTs

Machine Information Tab

The only required element in the Machine Information tab is the machine Name.  This will automatically filled from 

your entry in the Name Plate tab.  The location and building will be filled in from the default database items.  All 

other information is optional; however, it can be important for tracking instrumentation and report generation.

After you enter data in this tab, continue with data entry in the Dynamic Testing tab.

Fig 40:  Machine Information tab.
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Dynamic Testing Tab

The information entered into the Dynamic Testing tab of the create machine section are optional items.  Remember 

that the more information that is entered, the more accurate the results will be.

Fig 41: Dynamic Testing tab.

When an EP has been assigned to a motor, the serial number of the EP will appear in the EP Serial Number field.

Assigning an EP to a motor

1. From the Tools menu, click on EP, Mode, then Auto Assign.

2. Select the motor in the Machine Tree.

3. Set the main panel Sensor field to “EP.”

4. Connect the EXP 4000 to the EP.

5. From the Machine menu, click on Acquire EP Serial Number.

6. A message dialog will pop up to let you know that the EP was successfully assigned.
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Machine Properties

Clicking on the Machine Properties menu item opens a the Machine Properties dialog box as shown below to help 

you make changes to existing machine information on the machine selected in the Machine Tree.  The same tabs and 

features used in the process to create new machines are available.  You can add or change data as needed to correct 

or complete your information.

Fig 42: Machine Properties dialog box.

Acquire EP Serial Number

When the EXP4000 is connected to an external EP device, clicking on the Acquire EP Serial Number item permits 

association of a particular EP with a Motor ID.  This will enable the direct storing of data taken via an EP without 

the need of selecting the motor prior to testing.   After you click on this menu item, the software checks for the 

requested information and notifies you if the procedure was successfully completed.

Reset EP Serial Number

Clicking on the Reset EP Serial Number item disassociates a machine with an EP serial number so the EP can be 

re-associated with a newly-installed machine.  After you click on this menu item, the software completes the 

disassociation and you an then re-associate another machine with this EP by clicking on the Acquire EP Serial Number 

item.
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Thresholds Menu 

An electrical test model is a set of thresholds used as a guide against which the machines will be tested.  The 

EXP4000 compares test results with the electrical model’s predetermined tolerances.

Fig 43: Thresholds Menu

Select Test Model

Clicking on the Select Test Model menu item opens a dialog box like the one shown below, which you will use to 

designate the model you will use to test your motors.

Fig 44:  Select Test Model dialog box.

1. Click on the Thresholds menu.

2. Click on Select Test Model.

3. Select a test model from the Select Test Model dropdown list.

4. When you find the test model you need, click on it then click on the OK button.
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Create Test Model

When you click on the Create Test Model item, a new window opens as shown below.  You will use this window 

to define the thresholds for the test model.  This is useful for creating templates for motors in different service 

environments.  

1. Click on  the Thresholds menu.

2. Click on Create Test Model.

3. Type a name for the model in the Test Model Name field.

4. For each test type, enter the caution and warning thresholds.  Adjust thresholds by clicking the up and down 
arrows or by entering numbers directly in the fields.  

NOTE:  For the Voltage Level test, enter caution and warning level thresholds for over and under voltages 

independently from each other.

5. After you have entered your criteria, click on the Create button.  This will save the new test model and return to 
the EXP4000 window.

Fig 45: Create Test Model dialog box.
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Edit Test Model

1. Clicking on the Edit Test Model menu item re-opens the Select Test Model dialog box so you can select the model 

to edit.  

2. After selecting the model and clicking on OK, the Create Threshold window opens so you can revise the 
thresholds for a particular electrical test model.  

Delete Test Model

1. Clicking on the Delete Test Model menu item opens the Select Test Model dialog box so you can select the model 

to delete.

NOTE:  Test models that are currently assigned and the default test model (default elec) cannot be deleted.

2. When you attempt to delete a test model, a warning dialog opens to ensure that you want to complete the 
operation.  
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Tools Menu

The Tools menu has a number of items that will assist in monitoring machines.   

Fig 46:  Tools menu.

Scope

Clicking on the scope menu displays a virtual oscilloscope.  The virtual scope displays currents, voltages, or 

acceleration as a function of time and frequency.  It provides information on:

 � Phase-to-phase voltage

 � Phase-to-phase current

Fig 47: Virtual Scope tool.
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Items found in the Settings menu provide you with options for defining the scope’s display properties. 

Fig 48: Scope tool Settings menu items.

Tools found in the bar below the Settings menu allow you to pause the scope display.  When the display is paused, 

you can click on the icons that appear to export data or save a screen shot of the displayed waveforms 

View Connections

This tools helps you view displays connections currently used.  Check Connections appears in red in the lower right 

corner (as in this example) if the connections are incorrect.  When the connections are correct, the Connections OK 

appears in green.

Fig 49:  View Connections window.
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Transient Analysis

The Transient Analysis tools helps you capture startup transients via voltage and current vs.  time, and torque vs.  

time.  

A button at the top left of the Transient Analysis window provides you with two options to acquire transient data: 

Triggered Acquisition and Acquire Now.

Selecting Triggered Acquisition opens a dialog box of the same name that helps you select the trigger source and 

level along with the acquisition time, CT, and pre-trigger time.

Fig 50: Triggered Acquisition dialog box.

Selecting Acquire Now opens the Manual Acquisition dialog box, which you can use to specify the Acquisition time 

and CT selection.  After specifying these parameters, clicking on OK starts the acquisition process.

Fig 51: Manual acquisition dialog box.
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Fig 52: Transient Analysis—Voltage and current vs. time.

Fig 53: Transient Analysis—Torque vs.  time.

When clicking on any point on either the voltage or the current displays, a marker depicts the point in both panels, 

and the voltage and current data are displayed for that instant in time. The Torque vs.  Time tab displays two different 

views of the instantaneous torque.  The unfiltered torque displays in red showing the air gap torque’s highest level 

of dynamic behavior calculated from the currents and voltages collected.  The filtered torque displays as a blue line 

showing the same information, but with a lower dynamic resolution.  The blue line can be considered the short time 

average of the red line.  Additionally, the blue line describes the fundamental behavior of the torque versus time 

while the unfiltered red line describes the highest level of dynamic torque.

NOTE:  Click the right mouse button over the cursor to open a dialog box that allows you to delete data to right or 

left of the cursor.
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EP

The EP menu item  gives you access to calibrate the EP and view the EP calibration.  You can also select the EP mode 

to use auto assign (when acquiring an EP serial number) or not, or to use caching only.  

Checking the Use EP Caching menu item reduces the time needed to begin acquiring EP readings.  Start of 

acquisition without EP caching is approximately 45 seconds.  Enabling caching reduces start of acquisition time to 

approximately six seconds.  

Fig 54: EP menu items.

To view the EP calibration information, connect the EP to the Surveyor EXP AC then click on View EP Cal.

Clicking on Calibrate EP opens the EP Calibration Wizard as shown below.  Use the wizard to facilitate calibration 

procedures and to configure CT connections.  For more information on EP calibration, click on Help then EP 

Calibration.

Fig 55: EP Calibration Wizard.
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Run Electrical

This tool is an alternate method for starting the electrical data collection.  This option has the same effect on the 

application as clicking the Run Electrical button found in the lower right section of the Explorer window. 

Looped Acquisition

The Looped Acquisition menu item contains two sub-items: Continuous  and Timed.  Continuous mode will run as 

many consecutive tests as specified, with no interval between tests.  

Fig 56: Continuous Looped Acquisition.

Timed mode allows you to specify a number of continuous looped acquisitions to be repeated in intervals that you 

specify.  

Fig 57:  Time-Looped Acquisition.

Dropdown lists help you select the starting and ending time conditions.
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Operating Curves

The Operating Curves tool provides you with options for graphically viewing the electrical data for a particular test.  

The tool has three options: Torque vs. Speed, Efficiency vs. Load, and PF vs. Load.

Fig 58: Torque vs. Speed operating curve display.

Fig 59: Efficiency vs. Load operating curve display.

Fig 60: PF vs. Load operating curve display.

EXP4000 Software Overview

56 Baker EXP4000 71-005 EN V9 User Guide               www.megger.com



Raw to CSV

This tool provides you with the means to convert .raw test files to comma separate value (CSV) files.

Speed Override

The Speed Override tool is used to manually enter the operating speed prior to performing electrical measurements.

Fig 61: Speed Override selection dialog box.

Test Notes

The Test Notes menu item opens a dialog box that helps you create memos and identifies who tested the motor ID.

Fig 62:  Test Notes dialog box.
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Options

The Options tool provides you with the means to customize the data displayed and how the electrical data is 

collected.  Clicking on the Options tool opens the Options window, which includes two tabs: Display and Acquisition.

Display Tab

Use the Display Units field to define whether values will be displayed in Imperial (U.S.) or Metric mode.  The 

differences lie in that  Imperial (U.S.) prefers Hp and lb-in for output power of the motor and torque, respectively; the 

metric system chooses to display kW and Nm for the same physical quantities.  

The Voltage field allows you to select line to line or line to ground values when displaying voltages.

The Database Directory field and Browse button help you select the location of the test database. 

Fig 63: Options window—Display tab.
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Acquisition Tab

The Acquisition tab is used to select how the electrical data is collected.

Fig 64: Options window—Acquisition tab.

The Electrical Acquisition Options are used to change the acquisition time and define the harmonics to save.  You will 

also use this section to define the minimum and maximum frequencies of interest.

The Spectrum Acquisition Options are used to define the acquisition time length, the maximum frequency of the 

spectrum displayed, and the lines of resolution (LOR) to display.  The LOR controls the number of frequency bins 

(lines) that are displayed in the initial spectrum presentation.
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Help Menu

The Help menu provides access to several information resources to help you learn how to use the product more 

effectively and to assist you in your testing efforts.

An electronic copy of the user manual can be access along with additional supporting help targeted at the window 

currently opened when the Help item is selected.

Click on the About menu item to access current version information and a tool to check for software updates.  

The Release Notes menu item opens a document showing details about recent software improvements.

Clicking on the EP Calibration item opens a document describing the EP calibration process in detail.

The Motor Master+ item provides a link to the Motor Master+ website, which is an outside resource for learning 

more about motor testing, repair, and replacement technology and options.

Fig 65: Help menu.
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6 — VFD4000 Analysis Software Option

Variable-frequency drives (VFDs) are commonly used and highly useful.  However, they can be difficult to analyze due 

to their inherent variable nature.  

Operation Details

 The VFD Details window can only be activated if the measurements were taken in VFD mode.  This window displays 

the dynamic behavior of voltage level, torque, frequency and speed as a function of time.  

1. To  activate VFD mode, click on the Machine menu, Machine Properties item.

2. In the Machine Properties window Name Plate tab, check the VFD box.  

VFD Mode

The EXP4000 has two modes of operation: VFD, and non-VFD (60Hz or 50Hz) line operated.  

For these two modes the connection requirements are slightly different.  In VFD mode, the Autophasing feature is off.  

Correct phasing of CTs with respect to voltage leads needs to be ensured by the operator.  

Each CT must be connected to the correct phase and with the correct polarity; otherwise, the results displayed will 

not be correct.  The following table displays issues and their corresponding solutions.

Table 1: Testing Issues, possible connection causes, and actions.

Issue Possible Causes Action

V- and I- sequence do not coincide. Voltage is connected in abc and 
current in acb sequence, or vice 
versa.

Swap two CT connections (for 
example, swap red and yellow CT 
positions).

Speed negative, Torque negative, kW 
positive, pf positive.

Voltage and currents are connected 
acb with respect to electrical 
hardware.  Displays that the VFD 
is turning in negative direction, 
motoring.

To obtain positive rotation data, 
exchange Voltage clip from red to 
yellow, and exchange CT from red to 
yellow.  Keep orientation of CT the 
same.

Three power factors (shown in 
Power Quality domain, power result) 
are negative or load is very wrong 
(FAR too high or FAR too low).

CTs are facing the wrong direction or 
connected to the wrong phase.

a) Turn the three CTs around (reverse 
direction of arrow).

b) Exchange cyclical locations of CTs 
(red to yellow, yellow to blue, blue 
to red).  If results still not correct, 
perform this step one more time; 
otherwise check a). 

Speed negative, torque positive (or 
vice versa).

a) Connected to a generator and not 
to a motor.

b) CTs  polarity is wrongly connected.

a) Everything is fine

b) Turn the CTs around (reverse 
direction of arrow).

NOTE:  If in VFD mode, the voltage level is only displayed as a function of time. This mode of operation is not a pass/

caution/warning mode any longer.  All voltage level tests performed in VFD mode will yield a blue color.
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Waveforms

In VFD mode, voltage and current for a phase is shown.  

1. To open this window, click on the Connection domain button.

2. Click on the Waveforms button in the Connection domain panel.

In VFD mode, the voltage and current measurements can be displayed for only one phase at a time, as you can see in 

the example below.

Fig 66:  VFD waveform display.
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VFD Details Domain

In VFD mode,this window displays the dynamic behavior of voltage level, torque, frequency, and speed as a function 

of time.

As with any graphical display within the EXP4000 software, zoom and printing features are available.   

Fig 67: VFD Details window.
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7 — Continuous Monitoring Software Option

Using a streaming process, the CM4000 Continuous Monitoring Software evaluates important operating values 

of a machine application including triggered acquisition and recording.  It acquires 11 samples per second on 41 

parameters.  

The graphical user interface can be rearranged during operation to suit your particular analysis needs.  If recording, it 

stores all available channels, not only the ones displayed.  

Fig 68: Continuous Monitoring – Main Panel

A large number of independently operating triggers can be set and the stored data can be viewed.

NOTICE:  Because the data generated over several days by the Continuous Monitoring software is larger than what 

a Microsoft Access database can accommodate, it is stored as a separate file within the same folder as the motor 

database file.  The external data files generated for each CM recording event contain the motor database name 

suffixed with a recording event number.  The data files must be kept together with the motor database for any data 

backup/move operations.
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File Menu

The File menu is directly linked to the EXP4000 software.  You can create a new database, open an existing database, 

close an existing database, or exit the program.  

Fig 69: File menu.

Machine Menu

The Machine menu is interlinked with the EXP4000 software.

Fig 70: Machine menu.

Using the items in this menu, you can open the machine tree, create a machine, edit a machine, and acquire or reset 

the EP serial number.  Gathered information is recorded to the database.

Tools Menu

The Tools menu allows you to access the virtual scope or view the connections.  Like other menus, the Tools menu is 

directly linked to the EXP4000 software.

Fig 71: Tools menu.
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View Menu

Several preset views are available to evaluate data.  Change views by clicking on the related item in the View menu.

You can use the views as they are configured, or you can customize them by hovering the mouse cursor over the 

view you want to customize, then click the right mouse button to open dialog boxes used to modify the related view.

Fig 72:  View menu.

Table 2: View menu items and descriptions.

View Menu Item Description

Volts/currents Root mean square of the current through phases A, B, and C.  This number should 
be between 30% and 110% of the name plate current.

Voltages Displays the root mean square of the voltage for phase A, B, and C in volts. 

Currents The displays the root mean square of the current through the phase A, B, and C CTs 
in amperes along with the average of the root mean square values of the 3 phase 
currents in amperes.

Power factor The displays the power factor and the average power factor of phases A, B, and C 
.  These values are always equal to or smaller than one, and they increase with the 
load.

Power This displays the single-phase real power for phase A, B, and C and the total power 
in kilowatts.

Apparent power Displays single-phase complex power (9 kVA) values for phases A, B, and C in 
kilovolt amperes.

Reactive power Displays single-phase complex power for phases A, B, and C along with the sum of 
the thee phases in kilovolt amperes.

Z angles Displays the angle between and the current phasors of phase A, B, and C and the 
average angle.  This number will typically vary between 90 degrees at no load to 20 
degrees at full load for induction motors.

Machine This view displays power out, torque, speed, and percent load.  The power out is the 
mechanical output power.  The torque is the estimated torque in Nm or lb-in.  The 
speed is the estimated speed of rotation of the shaft in RPM.  The percent load is the 
output load with respect to the motor’s rating in percentage.

New view You can create a custom view to display the items necessary to your operation.

Continuous Monitoring Software Option

www.megger.com 67



Options Menu

The Options menu has two items to choose from: Graph Plot Mode, and Event Triggers.

Graph Plot Mode

Within the graph plot mode, choose from sweep or continuous.  When operating in sweep mode, a red bar will 

sweep from left to right across the screen.

Fig 73: Options menu.

In continuous mode the tool will continue to gather data and the screen will change as it reaches the far side and 

continues forward.

Event Triggers

Event triggers are useful for monitoring data for predefined machine events.  When the chosen condition exists, 

the data will be recorded for review.  The software will continue to record all channels until all triggers have been 

recorded.  At that point, the software will stop and all events can be reviewed.  The software can monitor any or all 

of the 41 active triggers listed.  All channels are continuously monitored and each trigger creates a separate event, 

even if the time is overlapping.

Fig 74: Event Triggers window.
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1. To set up event triggers, click on Options, then Event Triggers.

2.  Check the box for each trigger needed.

3.  Set the parameters needed for each trigger:

4. Click on OK to save your settings.

Table 3: Event triggers Options menu parameters and descriptions.

Parameter Description

Start Condition Set this to either greater than or less than the value.  Click on down arrow to reveal 
other choices.

Start Value Type the number value appropriate for this trigger.

Stop Condition Set this to either greater than or less than the value.  Click on down arrow to reveal 
other choices.  Remember this must be different from the start condition.

Stop Value Type the number value appropriate for this trigger.  Remember this must be different 
then the start value.

Pre-Trigger (sec) Number of seconds prior to event the software records data.

Post-Trigger (sec) Number of seconds post to the event the software records data.

NOTE:  If the Pre- and Post-Triggers are set to zero, the data that is recorded is just the event.  If these are set to 

greater than zero, data will be recorded that gives information on what led up to the event and what happen after if 

occurred.

General Operation Icons

The CM4000 software has a few built-in icons that provide shortcuts to specific operations.  They are shown in the 

graphic below.

Fig 75: CMS general operation icons.
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Modifying the Continuous Monitoring Tool

The continuous monitoring software tool is customizable.  It features 41 different gauges and graphs that can be 

added to your display or modified to enhance the value of information being collected.

You can set up the tool with as many of the graphs and gauges as you prefer; and you can change these elements to 

suit your needs.  This is accomplished by hovering the mouse cursor over specific areas of the window and clicking on 

the right mouse button.  

Adding a New Gauge or Graph

1. With the cursor in a white space around the existing gauges, right-click the mouse button and a menu will pop 

up for adding a new gauge or graph. 

2. Click on either New Gauge or New Graph.

3.  A list of available object will appear.  A few of the options are shown in the example below. 

4. Click on the desired gauge or graph to be added.

5. The new object will appear on your display and can be positioned as needed within the window.

Fig 76: New Gauge / New Graph menu with sample items. 
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Moving Gauges and Graphs

1. Hover the mouse cursor over the item you want to move and click on the right  mouse button.  The menu shown 

below appears.

2. Click on Move.  A hand graphic appears over the object to move.

3. Drag the object to the new location and click the left mouse button to set the object in place.

Fig 77: Move menu item—right mouse button click.

Setting Gauge and Graph Scales

1. Hover the mouse cursor over the object you for which you want to define scales then right-click the mouse.

2. Click on AutoScale or Manual as desired.  The dialog box shown in the example below appears when AutoScale 
is selected.  The Manual scale selection will have a similar dialog.

3. Set the values for scaling as needed then click OK.

Fig 78: Scale menu item—AutoScale. 
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Defining Channel for the Graph or Scale

1. Hover your mouse cursor over the object for which you want to define the channel then click on the right mouse 

button.  A menu like the one shown below appears.

2. You can click on any of the channels and the graph or gauge will automatically change to that item.  Descriptions 
for the available channels are provided in the table on the next page.

Fig 79: Channel menu.

Channel Descriptions

The table below contains channel descriptions that include input data to the CMS software along with data 

calculated by the CMS software.

Table 4: CMS channel descriptions.

Channel Description

IA RMS [A] Root mean square of the current through the phase A-CT in amperes.  This 
number is typically between 30% and 110% of the nameplate current.

IB RMS [A] Root mean square of the current through the phase B-CT in amperes.  This 
number is typically between 30% and 110% of the nameplate current.

IC RMS [A] Root mean square of the current through the phase C-CT in amperes.  This 
number is typically between 30% and 110% of the nameplate current.

Continuous Monitoring Software Option

72 Baker EXP4000 71-005 EN V9 User Guide               www.megger.com



Channel Description

VA RMS [V] Root mean square of the phase A voltage.

VB RMS [V] Root mean square of the phase B voltage.

VC RMS [V] Root mean square of the phase C voltage.

I Avg RMS [A] Average of the root mean square values of the three phases’ currents in amperes.

V Avg RMS [V] Average of the root mean square values of the three phases’ voltages.

I Imbal [%] Current imbalance percentage.  For machines under load, this value is typically 
smaller than one eighth of the voltage unbalance percentage.

V Imbal [%] Voltage imbalance percentage.

IA Angle [deg] Angle between the current phasor of phase A with respect to the voltage phasor 
of phase A (which is locked at 0 degrees).  This number is equal to Za angle.

IB Angle [deg] Angle between the current phasor of phase B with respect to the voltage phasor 
of phase A—in degrees).  This number is Zb angle degrees away from Vb angle.

IC Angle [deg] Angle between the current phasor of phase C with respect to the voltage phasor 
of phase A—in degrees).  This number is Zc angle degrees away from Vc angle.

VB Angle [deg] Angle between the voltage phasor of phase B with respect to the voltage phasor 
of phase A—in degrees.  This number typically should be within three degrees of 
either 120 or 240 degrees.

VC Angle [deg] Angle between the voltage phasor of phase C with respect to the voltage phasor 
of phase A—in degrees.  This number typically should be within three degrees of 
either 120 or 240 degrees.

ZA Angle [deg] Angle between the voltage and current phasors of phase A, in degrees.  This 
number will typically vary between 90 degrees at no load to 20 degrees at full load 
for induction motors.

ZB Angle [deg] Angle between the voltage and current phasors on phase B, in degrees.  This 
number will typically vary between 90 degrees at no load to 20 degrees at full load 
for induction motors.

ZC Angle [deg] Angle between the voltage and current phasors on phase C, in degrees.  This 
number will typically vary between 90 degrees at no load to 20 degrees at full load 
for induction motors.

Z Angle Avg [deg] Average angle between the voltage and current phasors on their respective 
phases, in degrees.  This number will typically vary between 90 degrees at no load 
to 20 degrees at full load for induction motors.

Power A [Kw] Single phase real power for phase A, in kilowatts.

Power B [Kw] Single phase real power for phase B, in kilowatts.

Power C [Kw] Single phase real power for phase C, in kilowatts.

Total Power [Kw] Total real power, in kilowatts.  It is equal to Pa + Pb = Pc.

Reactive Power C [kVAr] Single phase reactive power for phase C, in kilovolt amperes.

Reactive Power Avg [kVAr] Sum of the three phases’ reactive power, in kVAr.

V over F It displays the instantaneous ratio of voltage level divided by fundamental 
frequency of the voltages.  For all line-driven machinery, this must be a constant.  
For most VFD applications, it also needs to be near a constant value.
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8 — DC4000 Software Overview

DC4000 Machine Dynamic Analysis Software Tests and Features

 � Collect and graph field voltage

 � Collect and graph field current

 � Collect and graph armature voltage

 � Collect and graph armature current

 � Collect and graph transient data including start-up transient

 � Calculate instantaneous torque and graph torque ripple and torque spectrum

 � Calculate harmonics on all voltage and current data

 � Calculate current spectrum

 � Calculate voltage spectrum

 � Cursors available to analyze torque and current spectrum data

 � Export data for further analysis with programs such as MS Excel or Matlab

DC4000 Machine Dynamic Analysis Software Problem Types Identified

 � Firing sequence and firing angle issues

 � Voltage unbalance issues

 � Voltage level issues

 � Analyze voltage form factor

 � Measure incoming power condition

 � Failed SCR’s or IGBT’s

 � Diagnose brush fire

 � Diagnose brush chatter

 � Diagnose drive issues

 � Diagnose commutator problems

 � Analyze/troubleshoot response of motor circuit

 � Analyze/troubleshoot load issues

 � Analyze/troubleshoot I2R issues

 � Assists in setting neutral plane
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DC Connections for the EXP4000 Portable Sensors

DC Sensor Voltage Ratings

CAUTION:  The maximum rating of the EXP4000 DC voltage circuit is 500V.   A voltage of 500V is the maximum 

allowable voltage between any two of the four voltages and the ground clip.  Under no circumstance connect the 

voltage sensing circuit to higher voltage levels.  This will cause severe damage to the EXP4000.

Terminology

Va – Armature Voltage  Vf – Field Voltage

Ia – Armature Current  If  – Field Current

Fig 80: Basic Diagram—separated excited DC motor.

Connection Cases

Current Sensor Connections

1. Ia ≤ 600A, If ≤ 100A - Standard DC portable sensors

Standard DC4000 current sensors have two ranges:

 60 A/600 A     - Ia

 10 A/100 A     - If

CAUTION:  The maximum insulation voltage rating of the EXP4000 DC current transformer (CT) is up to 500 V, 

CAT III.  Under no circumstance connect the current sensors to circuits of any higher voltage.  This will cause severe 

damage to the EXP4000.
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2. 600 A ≤  Ia ≤  15,000 A, or If > 100 A   –   Optional DC portable sensors

Optional DC current sensors are available, extending the current range above 600 A for the armature, and/or above 

100 A for the field.

Fig 81: Connection diagram portable.

Voltage Sensor Connections

V ≤ 500 V

The EXP voltage connection is made directly across the armature voltage, or field voltage.  The graphic below shows 

the field voltage connections.

Fig 82: Portable field voltage connection (less than or equal to 500V).

V > 500 V

If the DC motor’s voltage exceeds 500 V, then a resistive bridge can be used to supply a lower, proportional voltage to 

the EXP4000.  The graphic below shows this done for the field voltage circuit.

Fig 83: Portable field voltage connection (greater than 500V).

DC4000 Software Overview

www.megger.com 77



DC4000 Software Navigation and Overview

Navigating the DC4000 software is accomplished via the main menu bar, the icon toolbar, and the Navigation Pane.

Fig 84: DC4000 navigation tools and options.

File Menu

The File menu is used to initiate database and folder management functions.

Fig 85: File menu.
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Creating a New Database

1. Click File, then New Database.  The Create New Database dialog box appears as shown below.  

2. Type a name for the new database that is relative to the operation then click OK.  This database will now appear 
in the tree view on the navigation pane on the screen.  

3. There are three types of database structures; choose the database structure appropriate to the application.

Fig 86: Create new database dialog box.

Opening a Database

1. To open a database, click File and Open Database.  A new window appears like the one shown below.   

2. Choose the appropriate database then click Open.  The database opened will be the active database used by the 
software.

Fig 87: Window used to open database.
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Closing a Database

To close a database, click File, then Close Database.  The database is automatically saved when you close it.  

Creating a New Folder

To create a new folder, click File then New Folder; the new folder will be added to the Tree View.

Fig 88: New folder.

Renaming a Folder

To rename a new folder, right-click on the new folder and then on Rename in the dropdown box.  The software will 

place a box around the new folder.  Type in the appropriate name and press enter or click outside the folder.

Fig 89: Rename folder.  
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Creating a New Test Item

1. To create a new test item, click File then New Test Item.  A wizard will appear to lead you through the process of 

creating a new machine.  

2. Type in the appropriate machine name and click DC machine. 

3. Click on the Next button to continue the process.

Fig 90: Create test item wizard.

You can type values directly in the fields or use the dropdown lists when available to make your selections.  Notice 

that required fields appear in bold type:

Fig 91: Create Machine window; entering nameplate information.

 � Number of poles (2, 4, or 6)

 � Has interpoles? (yes/no)

 � Winding: chooses between shunt, compensated shunt, or permanently excited

 � Insulation class: A, F, B, or H

 � Number of commutator bars; this is a display with an up/down arrow with progressive values in multiples of two

Required fields are listed in bold.  Yellow fields are recommended, but may be left at default values.  After all 

information is entered, click Finish to add the machine to the list in the Machine Tree.
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Using the Icons Toolbar for Feature Access Alternatives

Some of the features accessed from the File and Tools menus can also be accessed via the icons found in the toolbar 

just above the Navigation Pane.  These features are identified in the graphic below.

Fig 92: Icons used to access DC4000 features.

To enable the Create a New Folder and Create a New Dc Machine icons and their related functions, a folder must be 

highlighted.  After you click on an icon, the related features work essentially the same as using the main menu access 

with the exception of the Create a New Dc Machine icon.

Fig 93: Create New Dc Machine icon in toolbar.

When you click on this icon, rather than starting the Create Test Item wizard, a new folder is added below the 

highlighted folder when the icon is clicked.

Enter a name for the folder/machine then press Enter on your keyboard.  The Create Machine dialog appears for you 

to complete the nameplate information as described earlier.
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Viewing Properties

Clicking on the View Properties icon opens a window like the one shown below.

For Database and Folder levels, the window shows only the Location tab, providing the name and the modified date 

and time.  

At the machine level, additional tabs provide information about the nameplate, machine application, manufacturer, 

online testing, and bearings.  Some items within these tabs can be edited.

Fig 94: Right-click menu properties.
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Online Testing Menu

Before testing can begin, you need to provide the software with information needed to establish an understanding of 

what is being tested.  The Online Testing menu provides access to the tools needed to provide this information.  

Fig 95: Online testing menu.

Creating a DC Test Model

1. Click on the Online Testing menu then Create Dc Test Model.   The Create Test Model dialog box appears as 

shown below.

2. Type a name for the new model in the Test Model Name field.  

3. Change threshold levels as needed by highlighting the threshold level and typing in the appropriate values.  
Ensure that warning levels are higher than the caution levels.

Fig 96: Create new test model.
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Editing a Test Model

1. Click on the Online Testing menu then Edit Test Model.  The Select Test Model dialog box opens as shown below.

2. Use the Select Test Model to Edit dropdown list to locate and select the test model you want to edit.  

3. Revise the threshold levels as needed then click on the Apply button.

4. Make other changes as needed and click Apply.

5. Click on the Close button when you are ready to save the changes to the test model, leave the dialog box, and 
return to the main window.

NOTE:  The default test model cannot be edited or deleted.

Fig 97: Edit test model.

Deleting a Test Model

1. Click on the Online Testing menu then Delete Test Model.  A dialog box appears like the one shown below.

2. Use the Select Test Model to delete dropdown list to locate and select a test model. 

3. Click on Delete.  A confirmation box will appear.  Double check that this action is appropriate, then click on the 
appropriate response.

Fig 98: Delete test model.
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Using Looped Acquisition

The equipment can be set to continually run in a looped mode for a specified number of tests.

1. To access the looped acquisition mode, click on the Online Testing menu then Looped Acquisition.

2. Highlight and type in the appropriate number of tests or use the up and down arrows to select the desired 
number.  

3. Click Start after set up is complete.

Fig 99: Looped acquisition.

Timed mode allows you to specify a number of continuous looped acquisitions, to be repeated in intervals between 

tests that are user specific.  

Fig 100:  Time-Looped Acquisition.

You can chose the start time to either be immediate, or at a specific time and date.  Ending the testing can be 

similarly chosen.
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Tools Menu

There are two choices in the Tools menu.  The Motor Master+ tool gives you a research tool for motor efficiencies and 

workability.  It helps you find motors of like size, capabilities, and efficiencies.  It will also allow you to research motor 

details to see if it is working within prescribed tolerances.

Fig 101:  Tools menu.

Motor Master+ (option)

This option is available for download from the U.S. Department of Energy and is not installed at the factory.

Options

The Online Testing menu Options item provides access to three options that allow customization of several system 

parameters and database features: general, database, and archive.

General Tab

Use the General Options tab to set several system parameters.

The Calculator Path field and Browse button are use to identify the path to system’s calculator.  

The currency type can be set from here.  The default is “USD” (US dollars).  Type in the currency name, then use the 

dropdown list to select the symbol that represents the currency chosen.  

Fig 102: User Options/general options.

Use the Unit dropdown list to select either US or Metric.  

Screen colors can be changed by clicking on any of the color schemes listed in the Display Style dropdown.  

When you are satisfied with your changes, click Apply, and then OK.
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Database Tab 

Use the Database tab to set the location for the database files along with the type of database is to be used as the 

default.  For database types, you can select from Access Database (*mdb),  Sql Express Database (*.mdf), or Sql CE 

Database (*.bic).

Fig 103: User options/database.

Archive Tab

Use the Archive tab to set the location of where archives will be stored.  This is an important feature to remember if 

you ever need to locate an archive.  Also, the EXP4000 creates a large amount of data points.  These data points can 

create large databases of many mega-bytes.  Using this tab, you can define the Max Archive Size so that the data can 

be sent to different devices without issue.  If the database is larger than the archive max size, the software will break 

the file size into appropriate pieces and archive all of the data.

Fig 104: Options menu/archive.
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Software Testing Screen

The following description of the DC4000 software will aid in understanding how data is gathered.

Fig 105: DC4000 main screen.

CT Selection

On the top of the screen is a row of CT selections; one for the Field CT and one for the Armature CT.  There are two 

selections in each.  The Field CT is either 10A or 100A, whereas the Armature CT is either 60A or 600A.  

Fig 106: CT selection.

Nameplate Information

The information listed in the top portion of the screen is from the nameplate information that was entered when the 

machine was created.  This information is for reference for what was originally entered for the machine.

Fig 107: Nameplate Information.
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Center of Screen

Fig 108: Center of screen.

Parameters

 �  VA[%] =  Armature voltage percentage

 � VF[%] =  Field voltage percentage

 � IA[%] = Armature current percentage

 � IF[%] =  Field current percentage

 � Torque [ft-lb] = Torque in foot pounds (torque [N-m] = Torque in Newton meters)

 � Load [HP] = Load in horse power (load [kW] = load in kilowatts)

 � Load [%] = Percentage load

 � Va/If [%] = Percentage of synchronous speed equivalent

Waveforms can be zoomed in on to display cycles.  

 � Zoom in – Shift and hold left click button then drag box around area of interest.

 � Zoom out – Ctrl and right click button will return screen to original zoom level.

Practical data resulting from the waveforms

 � Firing sequence

 � Fining angles determined by amplitude of waveform

 � Broken SCR-extreme firing angle

 � Input voltage unbalance – Phases may be off; lack of symmetry in waveforms

 � 3 phase (3+, 3-) SCR switching – symmetrical waveforms, unless too much ripple is present

 � Typical DC drives will not have a flat waveform, due to six-pulse rectifiers or lack of ripple capacitors.

NOTE:  The field circuit does not interact with the load.  All load-related signatures will make it into the armature, 

but not the field.
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Bottom of Main Screen

Fig 109: Bottom of main screen.

Run Electrical Button

Click on Run Electrical to run the programmed tests.

View Connections Button

Clicking on the View Connections button opens the View Connections window, which provides you with a real-time 

look at the input signals.  

Armature voltage (Va), field voltage (Vf), armature current (Ia), and field current (If) are displayed in terms of average 

along with RMS, min/max, peak-to-peak, and percent of nameplate values.  

The graph shows the waveform shape.  

Load and torque are plotted versus time.

Fig 110: View Connections.

Exit Button

Clicking on the Exit button closes the software and returns you to your desktop.
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Test Domains 

The right side of the screen has a set of test buttons known as domains.  Click on each individual button to see a 

subset of buttons and several test results screens.

Fig 111: Test Domains.

 � Drive: Armature voltage level, field voltage level, armature voltage form factor, armature current ripple.

 � Machine: Armature current level, high field resistance, low field resistance, field current level.

 � Load: Torque ripple, load level.

 � Waveforms: Results only.

 � Spectrum: Field spectrum, armature spectrum, torque spectrum.

 � Harmonics: Results only.

Meaning of Button Color Code

 � Green: Machine running within tolerances.  No action needed.

 � Yellow:  Machine has exceeded a caution threshold.  Action should be taken to avoid future problems.

 � Red:  Machine has exceeded a warning threshold.  Action needs to be taken to correct problem.

 � Blue:  No applicable thresholds.
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Drive Domain

The Drive domain observes the upstream power.  Poor power condition will expose the motor to unnecessary stress.

1. Click the Drive button to view the domain tests.  

2. Click on any test to view the results or test logs.

Armature Voltage Level (Va)

Function

Armature voltage level is the main variable to control speed.  It is always created by the drive; speed varies 

proportionally to Va.

1. To change speed, change Va.

2. To reverse direction of rotation, reverse Va.

and

Fig 112:  Armature Voltage Level.

Table 5: Typical thresholds.

Threshold Value

Nominal -Va_Nameplate < Va < Va_Nameplate

Warning threshold 120% Va_Nameplate

Caution threshold 110% Va_Nameplate

Standards NEMA MG-1 Section 1-12.64
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DC Machine Va Troubleshooting

Result:  |Va| > Va nameplate

Possible Problem Root Causes

 � Drive settings and motor nameplate data do not coincide.

 � Drive or sensor problem.

 � Malfunctioning control circuit or feedback.

 � Neutral plane is off.

Possible Effects

 � Operates over rated speed motor.

 � Brush fire – Excessive brush sparking due to armature over voltage.

 � Commutator/brush damage.

Field Voltage Level (Vf)

Function

Connecting field voltage (Vf) onto the field winding causes the flow of  field current (If).  This creates the magnetic 

field necessary for torque generation.

Fig 113: Field Voltage Level.

Table 6: Typical thresholds.

Threshold Value

Nominal |Vf_field_weakening| < |Vf| < |Vf_base_speed|

Warning threshold 120% |Vf_base_speed | 80%f_field_weakening |

Caution threshold 110% |Vf_base_speed | 90% |Vf_field_weakening |

Standards NEMA MG-1 Section 1-12.64
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DC Machine VF Troubleshooting

Result:  |Vf| > |Vf_base_speed|

Possible Problem Root Cause

Case I: If <=  If_base_speed 

 � The field circuit’s resistance is higher than nameplate suggests.  

 � The field winding is running too hot.

 � Excessive contact resistance in the field circuit.

 � The field circuit’s lead lengths cause additional voltage drop prior to reaching field winding terminals.

 � Error entering the nameplate information when creating the motor.

Possible Effects

 � Contact resistances tend to increase over time.  Following this trend, the worsening contact resistance will lead 
to over speed trip, or over speed damage to the motor.

 � The field winding’s resistance varies too much from the drive’s motor model, which may introduce stability 
problems to speed or torque control.

 � On inexpensive motors with no speed control, the motor can overspeed, possibly causing damage.

 � Field lead lengths cause additional voltage drop prior to reaching field winding terminals.

 � Many drives have motor models used to offer higher quality speed/torque controls.  The field’s resistance varying 
too much from the drive’s motor model may introduce stability problems to speed or torque control.

Possible Problem Root Cause

Case II: If > If_base 

 � Drive setup problem.

 � Drive or sensor malfunction.

 � Short in field.

Possible Effects

Many drives have motor models used to offer higher quality speed/torque controls.  The field’s resistance varying too 

much from the drive’s motor model may introduce stability problems to speed or torque control.

Results: |Vf| < |Vf_field_weakening|

Possible Problem Root Cause

Case I: If < If_field_weakening 

 � Drive setup problem.

 � Drive or sensor malfunction.

Possible Effects

 � Over speed trip.

 � Over speed damage.

 � Series poles connected in series have been removed from the circuit.

Possible Problem Root Cause

Case II: If >= If_field_weakening

 � Field circuit’s resistance is lower than nameplate suggests.

 � Field winding’s temperature is below standard ambient (40º C) or motor may not have warmed up yet.
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 � Series elements of the field winding are not part of the circuit (turn-turn faults)

 � Nameplate vs. motor issue:

 � Error entering the nameplate when creating the motor.

 � Motor’s nameplate does not properly represent the field circuit.

 � If the field circuit’s resistance is lower than the nameplate suggests.

Possible Effects

If the field winding has a turn-turn fault, and if the field voltage has noticeable harmonic components, the shorted 

turns are being overheated.  The field’s ground-wall insulation will fail prematurely.  The amount of overheating due 

to the harmonic current content depends upon the amount of Vf_ripple/Vf.  

If the ambient temperature is below standard ambient (40º C), and the motor has not operated for a long enough 

time, then the field winding is still in the process of heating up.  If the drive does not change the Vf, then It will keep 

falling until the field winding reaches a steady state temperature.

Many drives have motor models used to offer higher quality speed/torque controls.  Varying the field winding’s 

resistance too much from the drive’s motor model could introduce stability problems to speed or torque control.

If the motor’s nameplate does not properly represent the field circuitry the field’s resistance varies too much from the 

drive’s motor model, which can introduce stability problems to speed or torque control.

DC4000 Software Overview

96 Baker EXP4000 71-005 EN V9 User Guide               www.megger.com



Armature Voltage Form Factor

Function

Form Factor is defined as:

Fig 114: Armature Voltage Form Factor.

This is a representation of how much armature voltage (Va) differs from a pure DC signal.  The closer the armature 

voltage form factor is to 1.0, (the theoretical minimum), the cleaner the signal.  An armature voltage form factor 

greater than 1.0 indicates AC current components in the armature and could mean more losses.

Table 7: Typical thresholds.  The following boundaries apply to DC motors operating from a rectified AC 

supply.

Threshold Value

Warning threshold 120% Va_Rated                      80% Va_Rated

Caution threshold 110% Va_Rated                      90% Va_Rated

Standards NEMA MG-1 Section 1-12.64

DC Machine Va Form Factor Troubleshooting

Result:  Va form factor is too high

Possible Problem Root Cause

 � Excessive voltage unbalance feeding the drive.

 � Unsymmetrical firing of the drive’s armature circuit switches.

 � The number of pulses generated by the drive is too low.

Possible Effects

The drive’s supply introduces excessive variations in the motor’s armature current.  This creates excessive torque ripple 

for applications defined as essentially torque ripple free.  Some applications (for example, extruders) function properly 

only if the supplied torque is sufficiently constant.  An excessive armature voltage form factor can cause excessive 

armature current ripple, resulting in additional commutator sparking.
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Armature Current Ripple

Function

This is current that produces no torque, yet produces heat.  Primarily, armature current ripple is the response of the 

circuit to the armature voltage AC components.  The inductance of the motor (and any additional users supplied 

inductance) can smooth out the armature current ripple at least to some extent.  A reduction in the RMS armature 

current ripple reduces the heating of the motor, while a reduction in peak-to-peak armature current ripple improves 

the commutating ability of the motor.

Fig 115: Armature Current Ripple.

Typical thresholds formula:

Table 8: Typical thresholds. 

Threshold Value

Warning threshold 2.5 < Ia ripple factor

Caution threshold 6.0 < Ia ripple factor < 2.5

Standards NEMA MG-1 Section 1-14.61

DC Machine Ia Ripple Troubleshooting

Result:  Armature current ripple is too high

Possible Root Cause

 � Va Form Factor is too high.

 � Drive malfunction.

 � Timing of SCR’s is wrong.

 � High AC voltage unbalance.

 � Armature circuit’s inductance too small.

Possible Effects

The drive’s supply introduces excessive variations in the motor’s  armature current.  This creates excessive torque ripple 

for applications defined as essentially torque ripple free.  Some applications (for example, extruders) function properly 

only if the supplied torque is sufficiently constant.

AC current components contribute more to heating than to torque generation – aging the armatures prematurely.  

Additionally, AC armature current components diminish the commutation capacity.

DC4000 Software Overview

98 Baker EXP4000 71-005 EN V9 User Guide               www.megger.com



Machine Domain

The Machine domain displays the issues directly related to the motor’s health.  A machine can be a motor or a 

generator.

Fig 116: Machine domain tests.

1. Click on the Machine domain button.

2. Click on any of the machine domain tests to view the test results or logs available.
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Armature Current Level

Function

The armature current (Ia) level represents the current flowing through the armature winding.

Fig 117:  Armature Current Level.

Table 9: Typical thresholds. 

Threshold Value

Warning threshold 120% rated < Ia

Caution threshold 110% rated <Ia<120% rated

DC Machine Ia Troubleshooting

Possible Problem Root Cause

 � Va level is too high.

 � Excessive torque is demanded by the load.

 � Armature may have stalled.

 � No current in the field.

Possible Effects

 � Brush fire.

 � Commutator/brush damage.
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High Field Resistance

Function

The calculated field resistance is compared to field resistance at rated conditions extrapolated to the upper boundary 

of the insulation class.

Fig 118: High Field Resistance.

Typical thresholds formula:

Table 10: Typical thresholds. 

Threshold Value

Warning threshold 120% RfHot < Rf

Caution threshold 110% RfHot , Rf , 120% RfHot

DC Machine Field Resistance Troubleshooting

Result: Field resistance is too high

Possible Problem Root Cause

 � High temperature.

 � High contact resistance.

 � Gauge of copper wire used for winding is too small.

Possible Effects

 � Shortened insulation life.
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Low Field Resistance

Function

The calculated field resistance is compared to field resistance at rated conditions extrapolated to the lower boundary 

of the insulation class.  

Fig 119: Low Field Resistance.

Typical thresholds formula:

Where:  

Delta T = per unit resistive increase for copper going from ambient temperature up to hottest allowable temperature 

for that insulation class.

Table 11: Typical thresholds. 

Threshold Value

Warning threshold 80% Rfcold > Rf

Caution threshold 90% Rfcold > 80% Rfcold

DC Machine Low Field Resistance Troubleshooting

Result

 � Turn-to-turn short

 � Field winding is below NEMA ambient temperature (400C)

Possible Effects

 � Shortened motor life.

 � Motor was very recently started.

 � Ambient temperature is very much below 400C.
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Field Current Level

Function

Field current (If) level corresponds to the current flowing through the field winding.  Note:  It is critical that the field 

current never falls too low or moves through the zero point, otherwise, the motor could over speed or stall.

Fig 120: Field Current Level.

Table 12: Typical thresholds. 

Threshold Value

Warning threshold 120% rated < If

Caution threshold 100% rated < If<120% rated

DC Machine If Troubleshooting

Result  

Field current level is too high

Possible Problem Root Cause

 � Vf too high.

 � Field circuit resistance too low or cold field windings.

 � Short in field windings.

Possible Effects

 � Too many I2R losses.

Result

Field current level is too low.

Possible Problem Root Cause

 � High temperature.

 � High contact resistance.

 � Long leads of small diameter copper.

Possible Effects

 � Over speed.

 � Stalling.
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Load

The load domain uses the motor as a sensor to look at the driven load.  To fully describe the steady state behavior 

two components are supplied.

Fig 121: Load domain tests.

Torque ripple:  Imaged data short-term behavior as well as load signature.

Load level history:  long-term behavior is made viewable.  

1. Click on the Load domain to view tests.

2. Click one either of the domain tests buttons to view the test results or logs available.
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Torque Ripple

Torque ripple is defined as the division of maximal torque divided by average torque during the acquisition period.

Fig 122:  Torque ripple.

Function

Torque ripple is a measure of how small the torque band is that surrounds a steady state average torque.  An 

important feature of the graph is the overall signature of the instantaneous torque (torque versus time plot).  This 

signature is the result of the load requirements of the drive.

Boundaries:  N/A – blue results

Results

Torque ripple is too high

A torque ripple in a ripple-free application indicates a problem.

Possible Problem Root Cause

 � Load problem.

 � Drive problem.
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Load Level 

The motor is required to deliver the load level requested by the load.  If there is a change in the load level, the root 

cause of that change lies in the driven load, not in the motor’s capabilities.

Fig 123: Load Level.

Function

Load level displays the test history of the load Dynamic monitoring identifies deterioration, which in most cases is 

gradual making trending important.  A gradual increase of load can be a sign of additional friction in the driven 

belt system.  A decrease can be traced back to a gradual blockage of the inlet of a fan or a pump.  Changing loads 

can only be diagnosed with detailed knowledge of the operating process.  Expertise in the particular driven load is 

necessary to determine whether the measured change is meaningful for predictive maintenance.

Table 13: Typical thresholds. 

Threshold Value

Warning threshold 120%<load

Caution threshold 110%<load<120%

Possible Problem Root Cause

In case load level is too high:

 � Load level problems are always caused by the load.

Possible Effects

 � Overheating.
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Waveforms

Waveform shape can be indicative of drive or motor problems.  For example, if every sixth peak of the field voltage 

or armature voltage waveform is smaller than the rest, it is possible that one SCR on a six-pulse rectifier is not firing 

properly.  Typically, a DC drive does not utilize ripple capacitors, so these waveforms typically are not flat.  

In addition, an entire missing tooth in the waveform could indicate a broken SCR.  Voltage unbalance should also be 

visible.  

Because there is more inductance in the field than in the armature, field current should normally be relatively small 

(high resistance) with less ripple than armature current.

Fig 124:  Waveforms.
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Spectrum

Spectra are useful for analyzing the frequency content of time-domain signals.  Armature voltage (Va), armature 

current (Ia), field current (If), field voltage (Vf) and torque are transformed to the frequency domain with the Digital 

Frequency Locked Loop (DFLL) and/or the Fast Fourier Transform (FFT).

1. Click on the spectrum domain button to view the spectrum tests.

2. Click on any of the test buttons to view the graphical spectrum test results.

Field Spectrum

Field voltage (Vf) and field current (If) should have similar spectra at lower frequencies.  As frequency increases, 

impedance also increases (the impedance is mostly inductive), resulting in the field current spectrum beginning to 

decrease in amplitude at higher frequencies.

The field circuit does not interact with the load, so any issues found in the field spectra have to be the result of the 

voltage sources, the field winding resistance, or the field winding inductance.

A field circuit powered by rectified three-phase AC should display harmonics at DC and multiples of the 6th 

harmonic:  6th, 12th, 18th, and so on.  No harmonics should be displayed at multiples of the second harmonic:  2nd, 

4th, 8th, and so on.  The presence of a second harmonic multiple could be due to voltage unbalance at the input of 

the DC drive.

For low ripple applications having excessive field current ripple, the inductance of the field circuit could be too low.  

This can be corrected by adding additional inductance externally to the drive and/or motor field circuits.

Fig 125: Field Spectra.  
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Armature Spectrum

As with the field spectrum, armature voltage (Va) and armature current (Ia) should have similar spectra at lower 

frequencies.  However, as frequency increases, impedance also increases (the impedance is mostly inductive).  As a 

result, the armature current spectrum should decrease in amplitude at higher frequencies.  If this is not the case, it is 

due to the machine.

The armature spectra is useful in identifying the following problems.

 � Raised bar.

 � Raised Mica.

 � Chattering.

 � Neutral plane problems.

Fig 126:  Armature Spectra.
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Torque Spectrum

The torque spectrum is composed of both electrical and mechanical components.  The electrical component can be 

reduced by addressing issues pertaining to the armature voltage form factor and armature current ripple—voltage 

unbalance, unsymmetrical firing of SCRs,  and insufficient drive pulses.  Some applications (for example, such as 

extruders) require very little torque ripple.  In these applications, it is critical that the ripple be addressed.  When the 

electrical components of the torque spectrum have been isolated, whatever is left is a mechanical signature.

Fig 127: Torque Spectra.
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Harmonics

Harmonics provide an indication of how much alternating current is feeding the DC current motor.  When a DC 

current motor is operated from a rectified alternating current source, rather than from a low ripple source such as a 

battery, the performance could be affected, possibly resulting in increased temperature and decreased commutation 

and efficiency.

A DC motor operated from rectified three-phase AC should display harmonics at the following locations:  DC, 6th, 

12th, 18th, and so on.  

1. Click on the Harmonics domain button to view the harmonics involved with the machine under test.

2. To view the harmonics in different formats, click on the tabs at the top of the screen.

3. Click on the check box to view all four channels or as few as needed for each channel:  field current (If), armature 
current (Ia),  field voltage (Vf), armature voltage (Va).

Fig 128: Harmonics.

4. Click on Export to view the available data formats.  This allows data to be displayed in several formats, copied to 
the clipboard, exported to a file for email, or sent directly to a printer.  Size definitions are also available.  The unit 
of measure is pixels.  

Fig 129: Export Harmonics.
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Result

The presence of any other harmonic—particularly the 2nd—indicates a lack of symmetry (except for the case of a 

single-phase rectifier).  

Unusually large harmonics represent:  

 � On armature voltage can indicate an unbalance on the rectified supply.

 � A blown SCR.

 � On armature current can indicate a high contact resistance.

Reports

1. To generate a report, select the test records desired.  

2. To select multiple test records simply use the Ctrl or Shift Keys as in any Windows® format.  

3. Click the right mouse button and select Add to Report.  The report will be created and a popup box will appear 
to save the report in a .rtf (rich text format), which can be opened in a number of different software packages.

Fig 130: Right-Click Menu/Reports.

Report examples are shown on the next page.
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Fig 131: Sample reports
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9 — Example Test and Report Generation

This chapter provides general guidelines for using the EXP4000 dynamic motor monitor; it does not cover all of the 

capabilities of the instrument.  

NOTICE:  Ensure that all safety procedures have been read and understood before making any connections to or 

attempting to use the EXP4000.  Refer to the “Safety Operating Information” chapter for details.

Motor Monitoring  

1. Prior to testing, ensure that the software has been set up properly along with an appropriate database structure.  

2. Ensure that machines have been accurately input and that all thresholds for each test have been established.  
Refer to the “Basic Software Overview” chapter for procedures and details.

3. Connect the EXP4000 to the machine to be tested as described in “Connecting the EXP4000.” 

4. After hookup has been completed, click on the Check Connections icon located on the main screen of the 
software.  

Fig 132: Check Connections icon.

5. If the connections are not correct and the machine is not a VFD machine the autophasing will automatically 
correct the connections.

6. If the machine is a VFD machine, autophasing is automatically turned off.  The connections must be manually 
corrected.  

7. Click Run Electrical.  This will run all preprogrammed settings for the machine connected.

8. When testing is done, scan the front panel results for accuracy.  If all is fine, write the testing to the database.
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Looking at Data Collected

It is important to look at the data gathered prior to writing it to the database.  If the data is deemed inadequate or 

mistaken, it can lead to misinterpretation of results.  Parameters can be adjusted and the testing redone if the front 

panel results are not reasonable for the machine.

Adjusting Parameters

If the torque-speed curve has a red dot appearing in the graph area it can be from a speed miscalculation, rotor bar 

problems, an incoming voltage problem or another cause.  Check the speed in the nameplate.

Fig 133: Torque speed parameter adjustment.

If the current draw is incorrect, check the CT selection from the front panel or the connections button.  The physical 

connection might not be right or there could be a bad connection.

Override Speed

If the speed is wrong, it can be overridden.  Click on the Tools menu then select the Speed Override item.  Enter the 

appropriate speed in the field and ensure the On box is checked.

Fig 134: Override speed.

Example Test and Report Generation

116 Baker EXP4000 71-005 EN V9 User Guide               www.megger.com



Adjusting Electrical Acquisition Time

This will affect absolute test time and increase rotor bar test resolution.  If rotor bar problems are suspected, it can be 

helpful to increase the acquisition time to obtain more data.

Fig 135: Electrical Acquisition options.

Spectrum Acquisition Options

This adjustment allows you to change the  frequency range being monitored along with the resolution.  This affects 

the voltage, current and the torque spectrums.

Fig 136: Spectrum Acquisition options.
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Looped Acquisition/Timed Acquisition

In the Tools menu, there are two types of loop acquisition modes: continuous and time looped.  In continuous looped 

acquisition mode a set amount of tests must be completed prior to the instrument stopping.  You should run a 

minimum of five tests, but 10 is the optimal amount.  

Fig 137: Continuous Looped Acquisition dialog box.

The second acquisition mode is time looped acquisition, which uses a defined time and date as the trigger.

Fig 138: Time Looped Acquisition dialog box.
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Creating Reports from the Report Generator

You can select multiple machines and results to generate a report, but only machines with a stored result can 

generate a report.  

1. Click on the File menu then Report Generator to open the Select Results window shown below.

2. Select the results to be included in the report by checking the box(es) next to the test result listed in the tree.

3. A machine summary page is automatically generated for each unique machine that is being included in the 
report.

Fig 139: Select Results window.

4. Use the Filter On menu to filter the displayed results by result status or by a specific data range.

Fig 140: Select Results—Filter On menu.
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5. Click on the Select menu to select the displayed results for reporting based on result status.

Fig 141: Select Results—Select menu,

6. Click on the Trending On menu to view trending parameters.  By clicking on the words “Trending On,” the 
filtering parameters for the menu toggle on and off.

Fig 142: Select Results—Trending On menu.

7. Click on OK after all parameters for the report have been developed.  The report wizard will now create the 
report you can save it as a .rtf type file.  It can then be reviewed in an assortment of software.  

8. A window appears to select the location for the report.  Enter the name and select the proper location then click 
Save.  

The software will create a Rich Text Format (.rtf)  document and automatically open it in your default text editor 

program.  This document can be edited to suit your needs (for example, you can add logos, notations of tests, 

network capable, and more.) These annotations can be made in the report through normal text editor functionality.  

Automatic Generation of Reports

Results for tests conducted with the EXP4000 are automatically saved.  Reports can be generated from this data, 

providing pass/fail data, numeric data, and appropriate waveforms from tests.  Charts trend this data, which is logged 

with test dates.  Analysis of test results over time is a key tool in a predictive maintenance program.
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10 — Appendix

Default Settings

 � Database Directory [InstallDir]\dB

 � Archive Directory [InstallDir]\Archives

 � EP Acquisition—Find machine associated with EP and auto assign it

 � Elec Acquisition Options:  10 Sec.

NOTE:   Two-pole machines are always acquired with at least 30 seconds despite the Elec Acquisition options setting.

Table 14: Default settings.

Test--Electrical Voltage Level Yellow Red

Over voltage 10% 20%

Under voltage 5% 10%

Unbalance 3% 5%

Distortion 5% 8%

Rotor Condition 45 dB 36 dB

Operating Condition 5% 10%

Service Factor 1 11

Over current 100% 110%

Efficiency 5% 10%

Payback Period 24 months 12 months

Spectrum Acquisition 3000FMax 1.37 Acq Time

Machine Tree Tree Level 1 Name

Tree Level 2 Name

Location

Building

Units US Customary

Currency Dollars ($)

Voltage Line to Ground

Machine Tree Filters  � Show Machines with No Tests

 � Show Tests with a Good rating

 � Show Tests with a Caution rating

 � Show Tests with a Warning rating

 � Do NOT Filter test by Date
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Connection Troubleshooting

General

The EXP4000 has two different modes of operation:  Non-VFD (60Hz or 50Hz line operated) and VFD (Variable 

Frequency Drive mode).  The connection requirements for each of these modes differ slightly.  For VFD connection 

troubleshooting, refer to chapter 7, “VFD anaylsis software option.

Non-VFD mode

This mode is operated in two different ways, with or without autophasing.  Autophasing allows for automatic 

correction for proper phasing of the current transformers (CTs) with respect to the connected voltage phases.  The 

autophasing feature is designed to recognize which CT signals belong with which polarity, and to which connected 

voltage signal.  It requires that the observed three-phase load be only an induction motor without power factor 

correction downstream of the point of connection.  If any other device is being observed, the autophasing feature 

needs to be turned off.

Table 15: Non-VFD issues, causes, and actions with autophasing feature turned on.

Issue Possible Cause Action

Monitored speed is wrong The device connected is either not a 
three-phase induction motor, or there 
are power factor correcting capacitors 
down the line from the point of 
connection.

Turn the autophase feature off and be 
aware that portions of the data (ind, 
speed, torque, rotor bar, efficiency) will 
be compromised.

Motor is running at high load, 
yet EXP4000 is displaying low 
load.

Autophasing failed (rare). Turn autophasing feature off.  Ensure 
proper phasing in connection.  Save 
data and send to Megger Baker 
Instruments support for further tuning 
of autophasing feature.

Motor is running at no load, 
yet EXP4000 is displaying high 
load.

Autophasing failed (rare). Turn autophasing feature off.  Ensure 
proper phasing in connection.  Save 
data and send to Megger Baker 
Instruments support for further tuning 
of autophasing feature.

Frequently Asked Questions

The EXP4000 shows the wrong speed.  It displays the operating speed as synchronous speed (3600, 1800, 

1200, 900 rpm, and so on for 60Hz operation; or 3000, 1500, 1000 rpm, and so on for 50Hz operation).  

However, the motor is running at speeds lower than that.  What is the problem?

When creating a new machine, the nameplate speed needs to be entered into the Speed [RPM] field in the Machine 

Properties dialog box.  If the synchronous speed was entered, the EXP4000 expects to be testing a synchronous 

machine—not an induction machine.  For a synchronous machine, displaying the synchronous speed is correct.

1. To edit the properties, click on the Machine menu then Machine Properties.

2. If desired, enter a new name in the Name field.  

3. Click on the Apply button.  A confirmation dialog will pop up saying “Machine Name has changed.  Create a 
New Machine?”

4.  Select No to update the existing machine.

5. Clicking on Yes will create a new machine.

6. All nameplate fields will now become editable.  Make changes as appropriate and click  Apply.  This will create a 
new machine without any test data.

7. To view this new machine, click on its name in the Machine Tree.
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8. You can now perform tests again.

NOTE:  An existing machine with recorded tests cannot be edited.  In order to edit this machine, you must delete all 

tests and then edit the machine.

How do I connect the EXP4000 to the secondaries of PTs if I have an open delta configuration?

Open delta configurations are very common in the field for medium-voltage or high-voltage motors.  

1. Ensure that all safety precautions are being followed when working with live voltage.  Refer to the “Safety 

Operating Information” chapter for details.

2. Identify the three different points in the MCC that show the same voltage (typically 100–200 volts) when 
connecting A–B, B–C, and C–A.  One of these pins typically is the ground pin.  

3. Clip the ground connection to a viable ground in the MCC.  

NOTE:  Typically, this will be one of the three pins previously identified.

4. Connect the three phase clip-ons to each of the identified pins.

How do I connect the EXP4000’s portable CTs if I have only 2 CTs installed in my medium or high voltage 

motor?

The sum-of-currents concept applies in this situation.

1. Connect the first two portable CTs to phases A and B.  

2. The third CT needs to be connected to both CTs around the other phases.  Make sure that the third CT totally 
closes around both currents of phases A and B.  If the CT doesn’t totally close, it will monitor much less current.

NOTICE:  The third CT needs to be monitoring the SUM of both currents, and not the subtraction.  This means that 

the orientation of the wires through the CT has to be such that the currents add and do not subtract.  If the wires 

are set such that the currents subtract, the EXP4000 will monitor a very high current unbalance through that CT.  If 

this is the case, take one of the two wires out of the CT; and introduce it into the CT in the opposite direction with 

respect to the CTs arrow.

Blue Results

Blue results are results that have no threshold comparison, but give valuable information about the machine.

Table 16: Conditions under which tests show blue results.

Test Result

Voltage Level Always for VFD mode; never in non-VFD mode.

Efficiency No entry of stator resistance.   

No comparable motor found in database.

Recovery time Blue condition for yield.

Data missing for at least one of the following:

 � Hours per day

 � Days per year

 � $ per kWh

Torque ripple Always

Details (all) Always

Current Imbalance Load <= 25
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Glossary

Table 17: Glossary of terms.

Term Definition

Average Power Factor Average of three single phase power factors.

Clampons Split core clamp on CT’s.

Clipons Clips for voltage pickup.

Crest Factor Difference between the sine wave peak and the RMS value.

Current The time rate of flow of electric charge, in the direction that a 
positive moving charge would take and have magnitude equal to the 
quantity of charge per unit time: measured in amperes.

Efficiency Defined as output power divided by input power.

Electrical Model A group of Electrical thresholds.

EP External port.

Harmonics Periodic motion consisting of one or more vibratory motions that 
are symmetric about a region of equilibrium, as the motion of a 
vibrating string of a musical instrument.
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Term Definition

Haystack Name of the NEMA guideline to Vibration.  Speed versus Frequency 
in a double logarithmic scale.

Horsepower A foot pound second unit of power, equivalent to 550 foot pounds 
per second or 745.7 watts.

Kilowatt  A unit of power equal to 1000 Watts.

Load What the motor drives.

MCC Motor control cabinet.

Motor ID Unique name tot he motor to be tested.

NEMA Derating Factor Factor between 1 and 0.  Displays how much a motor has to be 
derated, according to NEMA, to accommodate for sub-optimal 
voltage conditions.

NEMA Unbalance Number commonly defined in percent according to an algorithm 
specified by NEMA.  Displays how much of relative unbalance is part 
of the voltage condition.

Newton-Meters Metric unit of torque.

Overcurrent Measure of operating current in percent, comparing to the motor’s 
nameplate.

Phasors  A vector that represents a sinusoidal varying quantity, as a current 
or voltage, by means of a line rotating about a point in a plane, the 
magnitude of the quantity being proportional to the length of the 
line and the phase of the quantity being equal to the angle between 
the line and a reference line.

Pound-Feet English system.

Power Factor Relative amount of operating current and voltage used to 
transmit power.  It is defined as the division of real power by the 
multiplication of current and voltage.

Service Factor Specified on the nameplate, displays the amount with which the 
rating of the motor may be multiplied for transient operation.

Test Domains The five testing regions within the  EXP4000.

Thresholds The point at which a stimulus is of sufficient intensity to produce an 
affect.

Torque Ripple Measure of time-varying torque divided by steady state, or average 
torque.

Total Harmonic Distortion Measure of harmonic content to a signal when compared to the 
amount of fundamental.

Triggering Method with which it is possible to start data acquisition when 
certain conditions of the signals are met.

VFD Variable Frequency Drive.

Vibration Model Defined as a group of mechanical thresholds.

Waveform Displays the shape of a signal with respect to time.
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Technical Specifications

Table 18: General specifications.

Element Description

CD/RW EXP4000 is shipped with either an internal or external USB interface CD R/W.

Computer OS Microsoft Windows XP Professional® or equivalent.

Battery Run time up to 3 hours.

Networking Compliant standards: IEEE 802.11b and IEEE 802.11g 

Data link protocol: Ethernet, Fast Ethernet, Gigabit Ethernet, IEEE 802.11b and IEEE 
802.11g

Power Power device is external.

Voltage requirements: 110/230Vac (50/60Hz)

Processor Data bus speed: 400 MHz.

Processor 1.4 GHz.

RAM Install size: 512 MB (upgradeable to 2GB).

Storage Hard drive: 40GB running at 4200 RPM.

Video Graphics processor.  Maximum resolution (external): 800 x 600 pixels. 

Sensors Current transformer (clamp on, Hall effect): 60/600A DC, 10A/100A DC,   4000A/7500A 
DC.

Current transformer (clamp on): 10A AC, 40/400A AC, 150A AC, 1000A AC.

Current transformers: 3000A AC.

AC voltage clips (1000V).

DC voltage clips.

Grounding clip.

AC Voltage Clips One set of three voltage clips plus one ground connection—color coded.

Maximum rated voltage: 1000V.

DC Voltage Clips Set of four—color coded.

Maximum rated voltage: 500V.

Case Dust proof, crush resistant.

Dimensions: 15.11 x 12.40 x 6.94 inches.

Power Supply 
Requirement

Input voltage: 100–240Vac.

Input current: 3.0A.

Input frequency: 50–60Hz
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Table 19: AC current transformer (CT) specifications.

Element Option/Specs Option/Specs Option/Specs

Current Clamp On 10A (AC) 40A (AC) 150A (AC)

Output Signal 10A/1V 10 mV/A 150A/1.5V

Measurement 
Range

.01A–10A .05A–40A .01A–150A

Insulation 600V RMS 600V for CAT IV  
1000V for CAT III

600V RMS

Jaw Opening 20mm 32mm 20mm

Accuracy

R = Reading

0.1–0.5A ≤ 2.5% of R+ 0.1mV

0.5–1A ≤ 2.5% of R

1–10A ≤ 1% of R

2 % + 0.015 A 0.1–1A: 2.0% of R ± 0.2mV

10–80A: 1%of R± 0.2mV

80–150A: 1.5%R ± 0.2mV

Weight 3 x 180g 3 x 114g 3 x 180g

Dimensions 139 x 51 x 30mm ea 150 x 70 x 30 mm ea 139 x 51 x 30mm ea

Table 20: AC current transformer (CT) specifications continued.

Element Option/Specs Option/Specs Option/Specs

Current Clamp On 400A (AC) 1000A (AC) 3000A (AC)

Output Signal 1 mV/A 1000A/2.5V 0.3 mV/A

Measurement 
Range

5A–400A .1A–1000A 5–3000A

Insulation 600V for CAT IV  
1000V for CAT III

600V RMS 1000V

Jaw Opening 32mm 57mm 8 inches

Accuracy

R = Reading

2 % + 0.04A 0.1–10A ≤ 3% ± 0.1A of R

10A ≤ 3% of R

50A ≤ 1.5% of R

200A ≤ 0.75% of R

1000A < 0.5% of R

1% of R

Weight 3 x 114g 3 x 550g

Dimensions 150 x 70 x 30 mm ea 111 x 216 x 45 mm ea
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Table 21: DC current transformer (CT) specifications.

Element Option/Specs Option/Specs Option/Specs

10A/100ADC 60A/600ADC 4000A/7500ADC

Output 10A: 100mV/A

100A: 10mV/A

60A: 10/mV/A

600A: 1mV/A

4000A/2V

7500A/1.5V

Measurement Range 100mA–100A 0.2A–600A 40A–7500A

Overload Red LED indicates overload 2000ADC continuous up to 
1 kHz

Working Voltage 600Vrms 600Vrms 600V

Accuracy 50mA–10A: 3% of R ± 
50mA

500mA–40A: ± 4% of R 
+50mA

40A–100A: ± 15% max @ 
100A

60A:

0.5–40A: 1.5% of R ± 0.5A

40–60A: 1.5% of R

600A:

0.5–100A: 1.5% of R ± 1A

100–400A: 2% of R

1.5%

Weight 11.6 oz 15 oz 4.25 lbs

Dimensions 231 x 36 x 67 mm 224 x 97 x 44 mm 13.23 x 5.4 x 2.0 inches

Table 22: Connector specifications.

Function Number Type

AC/DC Voltage Port 1 Cannon Jack

AC/DC Current Port 1 Cannon Jack

Source Outlet 1 Standard 110–230V

EP/Vib Port 1 Cannon Jack
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Armature voltage level (Va)  93
Arrows and windows icons  6
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Blue results  123
Bottom of main screen  91

C
Calibrate EP  54
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Channel descriptions  72
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Connection domain  37
Connection Setup window  14
Connection troubleshooting  122
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Continuous Monitoring Software option  65
Create Test Model  48
Creating a DC test model  84
Creating a new database  79
Creating a new test item  81
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CT selection  89
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Current Level  28
Current Unbalance  29
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Database  39
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Database management  5
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DC machine Ia ripple troubleshooting  98
DC machine Ia troubleshooting  100
DC machine If troubleshooting  103
DC machine low field resistance troubleshooting  102
DC Machine Va form factor troubleshooting  97
DC machine Va troubleshooting  93, 94, 97, 98, 100, 101, 102, 

103, 106
DC machine VF troubleshooting  95
DC sensor voltage ratings  76
Default settings  121
Defining channel for the graph or scale  72
Delete Test Model  49
Deleting a test model  85
Demodulated Spectrum  32
Display tab  58
Drive domain  93
Dynamic Testing tab  45

E
Editing a test model  85
Edit Test Model  49
Effective Service Factor  23
Efficiency  25
Environment conditions/storage  3
EP  54
EP Caching  54
EP Calibration  60
EP Calibration Wizard  54
Event Triggers  68
Example test and report generation  115
Exit  41
Exit button  91
EXP4000 connections to motor terminals  13, 16
EXP4000 software overview  39
EXP4000 software-specific features  6
EXP4000 tests  17

F
Field Current Level  103
Field Spectrum  108
Field voltage level (Vf)  94
File menu  39, 66
Frequently-Asked Questions  122

G
General operation icons  69
General safety precautions  1
Glossary of terms  124
Graph Plot Mode  68
Grey-shaded fields  6

H
Harmonic Distortion  19
Harmonics  22, 33, 111
Help menu  60
High Field Resistance  101

I
Installation requirements  3
Installing an EP1000  13

K
Keyboard shortcuts  11

L
Load  24, 104
Load level  106
Looking at data collected  116
Loop acquisition  55
Looped Acquisition/Timed Acquisition  118
Low field resistance  102

M
Machine domain  99
Machine information tab  44
Machine menu  42, 66
Machine Performance domain  23
Machine Properties  46
Machine tree  10
Manual phasor adjustments  16
Meaning of button color code  92
Modifying the continuous monitoring tool  70
Motor monitoring  115
Moving gauges and graphs  71

N
Nameplate Information  89
Name Plate tab  43
Navigating the software interface  5
New AC Machine  42
Numeric fields  6

O
Online testing menu  84
Opening a database  79
Operating condition (OpCond)  25
Operating Curves  56
Operational safety warnings  2
Operation details  61
Options  58, 87
Override speed  116

P
Parameters  90
Payback Period  27
Phasors  38
Physical setup of EXP4000 with portable sensors  13
Physical setup of the EXP4000 with EPs  14
Plant maintenance  5
Power  21
Power Quality domain  17
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U
Unpacking the unit  3
Upgrading databases from previous software versions  5
Using looped acquisition  86
Using the icons toolbar for feature access alternatives  82

V
VFD4000 analysis software option  61
VFD Details domain  63
VFD mode  61
View Connections  51
View Connections button  91
Viewing properties  83
View menu  67
V/I Spectrum  31
Voltage Level  17
Voltage sensor connections  77
Voltage Unbalance  18

W
Waveforms  37, 62, 107

R
Raw to CSV  57
References and glossary  124
Renaming a folder  80
Report Generator  40
Reports  112
Reset EP Serial Number  46
Result  112
Results panels and windows  8
Result tab  9
Rotor Bar  30
Run Electrical  55
Run Electrical button  91

S
Safety and general operating information  1
Safety warnings  2
Scope  50
Select Test Model  47
Sensor Ratios dialog box  44
Setting gauge and graph scales  71
Setup wizard/suggest button  14
Shipping the unit  3
Software testing screen  89
Software tips  11
Spectrum  108
Spectrum Acquisition options  117
Spectrum domain  30
Speed Override  57
Starting the software  6
Summary Report  41
Symbols and labels used on equipment  1
Symmetrical Components (Sym. Components)  38

T
Technical specifications  126
Test domain buttons  8
Test domains  92
Test domains and testing theory  17
Testing capabilities  17
Test Notes  57
Text fields  6
Thresholds menu  47
Tools menu  50, 66, 87
Torque domain  34
Torque ripple  105
Torque Ripple Result tab  34
Torque Ripple Trend tab  35
Torque spectrum  110
Torque Spectrum  36
Total Distortion  20
Transient Analysis  52
Trend tab  9
Trigger parameter descriptions  69
Two-CT solution  15
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